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Finding Documentation
To access complete and up-to-date product information, go to Citrix eDocs located at
http://support.citrix.com/proddocs/index.jsp and expand the topics for your product.
Licensing Documentation
To access licensing documentation, go to
http://support.citrix.com/proddocs/topic/licensing/lic-library-node-wrapper.html.

Getting Support
Citrix provides technical support primarily through Citrix Solutions Advisor. Contact your
supplier for first-line support or use Citrix Online Technical Support to find the nearest
Citrix Solutions Advisor.
Citrix offers online technical support services on the Citrix Support Web site. The Support
page includes links to downloads, the Citrix Knowledge Center, Citrix Consulting Services,
and other useful support pages.
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Installation Issues
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•

The Citrix Receiver for Linux requires 32-bit GStreamer codecs for HDX Mediastream
Multimedia Acceleration to work correctly. To use HDX Mediastream Multimedia
Acceleration on 64-bit operating systems, you must install the appropriate 32-bit
GStreamer codecs for your operating system before installing the Citrix Receiver for
Linux. [#201589]

•

To use the HDX Mediastream Multimedia Acceleration feature you must install
GStreamer 0.10.15 or above, before you install the client. This requirement is enforced
by the installer. If you have an earlier version of GStreamer installed, you will not have
the option of specifying that GStreamer is enabled for multimedia acceleration during
installation. [#225308]

•

By default, the Citrix Receiver for Linux may not install correctly on 64-bit operating
systems. To prevent this problem, you must install 32-bit sound and X server libraries
before installing the Citrix Receiver for Linux [#200461]

•

Installation of the Citrix Receiver for Linux fails if you attempt to install the client from
or to a localized path on the client device. [#224425]

•

The Debian and RPM installation packages for the Citrix Receiver for Linux include the
USB support feature as a separately installable package. When you install the client,
the USB support package is placed in the ICAROOT folder of the client install. You can
install USB support using this package at any time after installing the client, if required.
[#229125]

•

Openmotif 2.3.1 is not available as a Debian package. Openmotif is required if you want
to use the client graphical user interface. If you install the Citrix Receiver for Linux
using the Debian package and want to use the client graphical user interface, you must
install openmotif manually. As an alternative you can use the Web Interface without
installing openmotif. [#229127]

•

If you want to install the USB support package included with the Citrix Receiver for
Linux 11.100, you must ensure you remove any earlier versions of this package from the
client device before attempting to install the latest version. Note that this applies only
to the Debian installation package. [#229308]
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Other Known Issues
•

The arrow, Home, End, Page Up, and Page Down keys do not work in the simplified
Chinese locale on some Linux distributions. As a workaround, remove the following line
from the client's module.ini file:
UseLocalM=True

•

[#150369]
For some old Linux distributions, the Firewall dialog box does not accept non-ASCII
characters. If you want to enable non-ASCII characters on this dialog box, either
comment out or remove the following lines from the Wfica resource file in the client's
installation directory:
Wfica*ProxyAuthDialog.ProxyUsername*international: False
Wfica*ProxyAuthDialog.ProxyPassword*international: False
Note that due to a third party issue, this workaround may cause the client to shut down
unexpectedly on some old Linux distributions if a user double-clicks on the dialog box.
[#150143]

•

If you log on to a connection and your user name contains a Euro character, this
character does not display correctly on the Connection Status dialog box in the
Connection Center. There is no workaround for this issue. [#151152]

•

Selective trust allows only proxy types that do not specify a server (namely Auto, None,
and Wpad). Secure and Socks proxy settings are ignored. You can change this by editing
Trusted_Region.ini, using the instructions included as comments in that file. [#199319]

•

You cannot reconnect to a virtual desktop using the Reconnect Citrix XenApp option on
the Citrix XenApp menu. As a workaround, click the desktop icon for the virtual desktop
you want to reconnect to in the Citrix XenApp view on the main client window.
[#205538]

•

If you move a large file from a local mapped drive to a shared server folder, the file
size is truncated. When you open the file it is restricted to the truncated size. Note
that this occurs only for files 4Gb or larger in size. [#199215]

•

If HDX Mediastream Multimedia Acceleration is enabled, multimedia files may not work
correctly on the client device. For example, media files may not play at all, the media
player window may turn black after seeking, or audio may not synchronize or play at
the correct speed. As a workaround, disable HDX Mediastream Multimedia Acceleration
on the client device.
To disable HDX Mediastream Multimedia Acceleration for all client devices, modify
module.ini, setting the Multimedia parameter to "Off".
To disable HDX Mediastream Multimedia Acceleration for a single client device, modify
wfclient.ini, setting the SpeedScreenMMAVideoEnabled and
SpeedScreenMMAAudioEnabled parameters to "Off".
[#198305, 198337, 198369, 198370, 205952, 206253, 206304, 203605, 203607]

•
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If you have applications displayed on different monitors in a multimonitor setup, all
applications may appear on a single monitor after reconnection. This issue is seen only
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with the Compiz window manager. [#201028]
•

For a list of known issues seen when using USB devices with virtual desktops, see
http://support.citrix.com/article/CTX120090. [#205817, 205818, 205819]

•

You may experience the following problems when running the Citrix Receiver for Linux
on Fedora 12:
•

The operating system may become unresponsive after clicking the "..." button on
menus within the client graphical user interface. [#227963]

•

Audio files can be played only if HDX Mediastream Multimedia Acceleration is
enabled on the XenApp or XenDesktop server to which the client connects. Other
audio sounds, such as system notifications, cannot be played at all. [#224715]

•

The large font size applied to wfcmgr distorts the layout of the client graphical user
interface causing text truncation and loss of alignment on screen. As a workaround,
add the following line below Wfcmgr*fontList:\ in the wfcmgr file, found in the
client install directory at /.ICAClient/nls/<locale>/, where <locale> is en, de, or ja:
fixed;\
Note: If you are using UTF-8 encoding, the file is found at
/.ICAClient/nls/<locale>/UTF-8 [#228665]

Certain fonts included with Fedora 12 prevent the client from launching. As a
workaround, either remove the cjkuni-uming-fonts RPM package provided with your
Fedora 12 installation, or delete the fonts.dir file found at
usr/share/fonts/cjkuni-uming/ and run the command xset fp rehash to disable
the fonts as X core fonts. Disabling the fonts in this way leaves them available for
use on the system, if required. [#225305]
You may experience the following problems when running the Citrix Receiver for Linux
on Ubuntu 9.10:
•

•

•

Shortcuts for menu items, such as Alt + P to show the Application menu, do not
function. [#226001]

•

A blank window obscures the client graphical user interface when you open the
client. As a workaround, disable the visual effects provided with Ubuntu, by
selecting None on the Visual Effects tab in the Appearances Preferences dialog
box, available from System > Preferences > Appearance. [#227227]

•

When launching a virtual desktop session with the window size for the session set to
Default, parts of the desktop, such as the Start button on the Windows toolbar, are
obscured by the top and bottom panels of the operating system. As a workaround,
either set the window size for the session to Full Screen, or disable the visual
effects provided with Ubuntu, by selecting None on the Visual Effects tab in the
Appearances Preferences dialog box, available from System > Preferences >
Appearance. [#224559]

There is no structure to the folder Citrix XenApp creates, named Citrix Delivery
Center by default, in the Applications folder. All applications are displayed in a
single list. Note that this issue is seen only with Ubuntu Netbook Remix 9.10
[#227965]
You may see the following error if you leave sessions connected for a long period of
time, for example, overnight:
•

•
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Cannot read file:
"$HOME/.ICAClient/cache/Citrix/PNAgent/ResourceCache/<filename>.ICA". This is
because the client attempts to reconnect to the disconnected sessions after the original
ICA file containing the session information is deleted. As a workaround, restart your
sessions. If you are using Citrix XenApp and the Enable automatic reconnection from
the menu option is enabled, select Reconnect sessions on the Citrix XenApp menu to
restart your sessions.
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•

When running seamless sessions on multiple monitors, application windows do not
immediately gain focus when selected. [#227640]

•

Localized text cut from a local version of an application and pasted to a published
version of the same application is displayed in UNICODE format rather than the original
format. [#224426]

•

You cannot enter Japanese characters into certain fields in the graphical user interface,
even though the Japanese Input Method Editor (IME) is enabled on the client device. As
a workaround, copy and paste the required text into these fields. [#226936]

•

Attempting to copy files or folders with names containing specific Kanji characters
between local mapped drives and shared server folders fails. [# 226031]

Before You Begin
The Citrix Receiver for Linux provides users with access to resources published on XenApp
or XenDesktop servers. It combines ease of deployment and use, and offers quick, secure
access to applications, content, and virtual desktops. Users can connect to resources
published on XenApp servers using either individual ICA connections or, if using Citrix
XenApp, predefined ICA connection configurations from servers running the Web Interface.
Users can also connect to virtual desktops provided by XenDesktop, enabling them to use
those virtual desktops as if they were connecting to a local Windows desktop.
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New Features Introduced in Version
11.100
The following new features have been introduced in version 11.100 of the Citrix Receiver
for Linux.

Enhanced USB Support
The range of USB devices that users can interact with during a XenDesktop or XenApp
session has been extended. Supported devices now include those requiring isochronous data
transfer, such as Webcams, dictation devices, microphones, speakers, headsets, and
soundcards. See Configuring USB Support for more information.

Dynamic Client Drive Mapping
Dynamic client drive mapping enables users to interact with storage devices connected to
the client during a XenDesktop or XenApp session automatically, without the need to
manually map their mount points in advance. See Mapping Client Drives for more
information.

HDX Plug-n-Play Multi-Monitor Support
Multi-monitor support is now more flexible as it allows users' particular multiple monitor
configurations to be reflected in their virtual desktop. For example, users can configure
their XenDesktop environment with L-shaped, T-shaped and U-shaped monitor
configurations or with monitors of different sizes and resolutions.
Command line support for multi-monitor configurations has also been added. See I want to
make a session that spans multiple monitors for more information.

Support for Citrix Branch Repeater
Integration with Branch Repeater using a new variant of the Thinwire protocol provides
improved levels of graphics compression, optimizing the user experience and reducing the
amount of time taken to cache and re-use graphics between sessions.

Improved Audio Performance
Support for new audio codecs has been added. These provide enhanced high definition and
speech-optimized audio and in most cases use less bandwidth than previous audio codecs.
See Mapping Client Audio for more information.
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Improved Image Handling
Support for a new Thinwire image codec has been added. This provides improved image
compression and adds support for the Use Heavyweight Compression option in XenDesktop.
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Existing ICA Features Supported for
Connection to XenDesktop
The following standard ICA features are supported for connections to XenDesktop:

15

•

SpeedScreen Image Acceleration

•

HDX Browser Acceleration

•

Client drive, LPT, and COM port mapping

•

Printing using the Universal Printer Driver

•

SecureICA

•

Bi-directional audio

Deploying the Citrix Receiver for Linux
This section describes how to install, deploy, and remove the Citrix Receiver for Linux.
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System Requirements
The Citrix Receiver for Linux requires Linux kernel version 2.6.18 or above, with glibc 2.3.4
or above, libcap1 or libcap2, and udev support.
In addition, the native client (wfcmgr) graphical user interface depends on OpenMotif 2.3.1.
However, if you intend to run the client through the Web Interface or from the command
line, then OpenMotif is not required.
Systems running the Citrix Receiver for Linux also require the following:
•

6 MB of free disk space for the installed client and up to 13 MB if you expand the
installation package on the disk

•

256 color video display or higher

•

TCP/IP networking

Note: In addition, root-level administration privileges for the user device are required if
you plan to install USB support. End users cannot install this component themselves.

17

HDX Mediastream Multimedia
Acceleration
To use the HDX Mediastream Multimedia Acceleration feature, you must install GStreamer
0.10.15 or above, an open-source multimedia framework, before you install the client.
During installation, you then have the option of specifying that GStreamer is enabled for
multimedia acceleration. You can download GStreamer from
http://gstreamer.freedesktop.org.
Note: Use of certain codecs may require a license from the manufacturer of that
technology. You should consult with your own attorneys to determine if the codecs you
plan to use require additional licenses.
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User Requirements
Although you do not need to log on as a privileged (root) user to install the Citrix Receiver
for Linux, USB support is enabled only if you are logged on as a privileged user when
installing and configuring the client. Installations performed by non-privileged users will,
however, enable users to access published resources on the server using the Web Interface
through one of the supported browsers.
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Installing the Citrix Receiver for Linux
Before installing the client, ensure that you have at least 13 MB of free disk space
available. You can check the available disk space by typing one of the following commands
in a terminal window:

df -k <ENTER>

df <ENTER>

Note: If you are using the Web Interface in conjunction with Citrix XenApp, see the Web
Interface documentation for information about deploying the Citrix Receiver for Linux
with the Web Interface.
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Installing the Citrix Receiver for Linux
from the Web
The Citrix Receiver for Linux is available in Red Hat Package Manager (RPM) , Debian and
.tar.gz formats. RPM and Debian packages are generally easier to use, but give you no
control over the location of the installed files.
If changing the location of the installation is necessary in your environment, then install the
client from the .tar.gz file as described in To install the Citrix Receiver for Linux client
from a .tar file or CD.
You can download the Citrix Receiver for Linux in all of these formats from the support
pages of the Citrix Web site (http://www.citrix.com/).
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To install the Citrix Receiver for Linux
client from a .tar file or CD
If you want to enable USB support, then you must log on as a privileged user (root) on the
user device. All other features of the client are installed for your personal use only if you
log on as a non-privileged user.
The default directory for root user installations is:
/usr/lib/ICAClient
The default directory for non-privileged-user installations is:
$HOME/ICAClient/platform
(where platform is a system-generated identifier for the installed operating system. For
example, $HOME/ICAClient/linuxx86 for the Linux/x86 platform).
1. Open a terminal window.
2. Uncompress the .tar file and extract the contents into a temporary directory. For
example, for Linux platforms, type: tar xvfz packagename.tar.gz
3. Do one of the following:
•

Run the setup program by typing ./setupwfc and press ENTER

Or, if file names on the CD are displayed in uppercase and are followed by other
characters (such as ;1), type ./setupwfc* and press ENTER
A list of setup options appears.
•

4. Type 1 (Install Citrix Receiver for Linux 11.x) and press ENTER.
The installation procedure prompts:
Please enter the directory in which Citrix Receiver for Linux is
to be installed [default /usr/lib/ICAClient] or type “quit” to
abandon the installation:
5. Type the path and name of the required installation directory (and press ENTER) or
press ENTER to install in the default location. If you do not accept the default, you
must also specify the installation directory in the environment variable ICAROOT after
installation.
6. When prompted to proceed, type y and press ENTER. The installation procedure
displays the Client Software License Agreement and then prompts you for confirmation.
7. Type 1 and press ENTER. If you have a supported Web browser installed, you are
prompted to choose installation of the plug-in. If you require the plug-in, press y.
22

To install the Citrix Receiver for Linux client from a .tar file or CD
8. If you have KDE or GNOME installed, then you can choose whether to integrate them
with the client. Type y at the prompt to integrate the client with KDE or GNOME.
9. If you are logged on as a privileged user (root), then you can choose to install USB
support for XenDesktop and XenApp published VDI applications. Type y at the prompt
to install USB support.
Note: If you are not logged on as a privileged user (root), then the following warning
is displayed.
USB support cannot be installed by non-root users. Run the
installer as root to access this install option.
10. If you have previously installed GStreamer, you can choose whether to integrate
GStreamer with the client and so provide support for HDX Mediastream Multimedia
Acceleration. To integrate the client with GStreamer, type y at the prompt.
11. When the installation is complete, the main installation menu appears again. To exit
from the setup program, type 3 and press ENTER.

If you did not accept the default installation directory in step 5, then you must specify the
full path and name of the installation directory in the environment variable ICAROOT.
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Starting the Citrix Receiver for Linux
You can start the client either at a terminal prompt or from one of the supported desktop
environments (KDE or GNOME).
If the client was not installed in the default installation directory, ensure that the
environment variable ICAROOT is set to point to the actual installation directory.

To start the client at a terminal prompt
At the terminal prompt, type /usr/lib/ICAClient/wfcmgr and press ENTER (where
/usr/lib/ICAClient is the directory in which you installed the client). The main client
window appears.

To start the client from the Linux desktop
You can start the client from any desktop environment for Linux by navigating to it using a
file manager.
If you are using KDE or GNOME, you can also start the client from the menu. The client may
reside in different menus depending on your Linux distribution. The menu locations for
some popular distributions are noted below.

•

KDE
•

Red Hat, Fedora, Ubuntu, Kubuntu, Gentoo, Arch, and SuSE distributions: On the K
menu, click Applications > Internet > Citrix Receiver

•

Mandriva distributions: On the K menu, click Networking > Citrix Receiver

Other distributions: On the K menu, click Applications > Citrix Receiver
GNOME
•

•

All distributions: On the Internet menu, click Citrix Receiver
Clicking the Citrix Receiver option on a menu in the KDE or GNOME environment starts the
client. The main client window appears.
•
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To uninstall the Citrix Receiver for Linux
1. Run the setup program by typing /usr/lib/ICAClient/setupwfc and press ENTER.
2. To remove the client, type 2 and press ENTER.
Note: To uninstall the Citrix Receiver for Linux you must be logged in as the same
user who performed installation.
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To modify and repackage the Citrix
Receiver for Linux
You can customize the client configuration before installation by modifying the contents of
the client package and then repackaging the files. Your changes will be included in every
client installed using the modified package.
1. Expand the client package file into an empty directory. The package file is called
platform-major.minor.build.tar.gz (for example, linuxx86.11.0.nnnn.tar.gz for the
Linux/x86 platform).
2. Make the required changes to the client package. For example, you might want to add
some connection definitions so that each installation of the client already contains a
standard set of connections. You can add connection definitions to the appsrv.ini
template file located in: platform/platform.cor/config/appsrv.ini (for example,
linuxx86/linuxx86.cor/config/appsrv.ini for the Linux/x86 platform). Alternatively, you
might add a new SSL root certificate to the package if you want to use a certificate
from a Certificate Authority that is not part of the standard client installation. See
Configuring and Enabling the Client for SSL and TLS for more information about built-in
certificates. To add a new SSL root certificate to the package, copy the .crt file into
platform/platform.cor/keystore/cacerts (for example
linuxx86/linuxx86.cor/keystore/cacerts for the Linux/x86 platform).
3. Open the PkgID file.
4. Add the following line to indicate that the package was modified:
MODIFIED=traceinfo where traceinfo is information indicating who made the change
and when. The exact format of this information is not important.
5. Save and close the file.
6. Open the package file list, platform/platform.psf (for example, linuxx86/linuxx86.psf
for the Linux/x86 platform).
7. Update the package file list to reflect the changes you made to the package. If you do
not update this file, errors may occur when installing your new package. Changes could
include updating the size of any files you modified, or adding new lines for any files you
added to the package. The columns in the package file list are:
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•

File type

•

Relative path

•

Sub-package (which should always be set to cor)

•

Permissions

•

Owner

•

Group

To modify and repackage the Citrix Receiver for Linux
•

Size

8. Save and close the file.
9. Use the tar command to rebuild the client package file, for example: tar czf
../newpackage.tar.gz * where newpackage is the name of the new client package
file.
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Using the Citrix Receiver for Linux as an
"ICA to X Proxy" ("Server Side ICA")
You can use a workstation running the client as a server and redirect the output to another
X11-capable device. You may want to do this to deliver Microsoft Windows applications to X
terminals or to UNIX workstations for which a client is not available. Note that client
software is available for many X devices, and installing the software on these devices is the
preferred solution in these cases.
Note: The Client for Linux Version 9.x and later includes support for Sun Ray devices.
When you run a client, you can think of it as an ICA-to-X11 converter that directs the X11
output to your local Linux desktop. However, you can redirect the output to another X11
display. This means that you can run multiple copies of the client simultaneously on one
system with each sending its output to a different device.
A system with the Citrix Receiver for Linux set up as an ICA to X proxy.

To set up this type of system, you need a Linux server to act as the ICA-to-X11 proxy:
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•

If you have X terminals already, you can run the client on the Linux server that usually
supplies the X applications to the X terminals

•

If you want to deploy UNIX workstations for which a client is not available, you need an
extra server to act as the proxy. This can be a PC running Linux

Supported Features
Applications are supplied to the final device using X11, using the capabilities of the ICA
protocol. By default, you can use drive mapping only to access the drives on the proxy. This
is not a problem if you are using X terminals (which usually do not have local drives). If you
are delivering applications to other UNIX workstations, you can either:
•

NFS mount the local UNIX workstation on the workstation acting as the proxy, then
point a client drive map at the NFS mount point on the proxy.

•

Use an NFS-to-SMB proxy such as SAMBA, or an NFS client on the server such as
Microsoft Services for UNIX.

Some features are not passed to the final device:
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•

Audio will not be delivered to the X11 device, even if the server acting as a proxy
supports audio.

•

Client printers are not passed through to the X11 device. You need to access the UNIX
printer from the server manually using LPD printing, or use a network printer.

To start the Citrix Receiver for Linux with
"Server Side ICA" from an X terminal or a
UNIX workstation
1. Use ssh or telnet to connect to the device acting as the proxy.
2. In a shell on the proxy device, set the DISPLAY environment variable to the local
device. For example, in a C shell, type: setenv DISPLAY <local:0>
3. At a command prompt on the local device, type: xhost <proxy server name>
4. If the client is not installed in the default installation directory, ensure that the
environment variable ICAROOT is set to point to the actual installation directory.
5. Locate the directory where the client is installed. At a command prompt, type:
wfcmgr & If you get font errors on the local X display when you start the client, start
the font server on the proxy server.
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Supporting Faster Browsing
When using Microsoft Internet Explorer with Version 7.x or later of the client, this browser’s
performance with graphically rich pages or large JPEG and GIF images is improved using
HDX Browser Acceleration and ThinImage functionality. For this feature to function
correctly, ensure that the client device’s installation includes the libjpeg.so JPEG library.
This library is present in typical Linux installations, but may be missing in installations for
Linux terminals and network boot images.
If libjpeg.so is missing from your system, Citrix recommends that you contact your
distributor for a suitable installation package and installation instructions. On the Linux
platform, browsers still operate in the absence of this library, but HDX Browser
Acceleration does not function.
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Creating and Managing Connections
This section describes how to create and manage connections between the Citrix Receiver
for Linux and XenApp servers.
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Creating Connection Entries
Users can create two types of connections to servers:

•

A connection to a server desktop lets a user access the desktop of a server. The user
can run any applications available on the desktop, in any order.
Note: It is not possible to connect to a XenDesktop Workstation Desktop (VDA)
through a custom connection. Instead, the Web Interface or XenApp must be used.

•

A connection to a published application lets a user access a predefined application and
its associated environment. Published applications can be run in seamless mode, where
the applications appear to the client as if they are running locally, each application
running in its own resizable window.

To create a connection
1. Start the client. See Starting the Citrix Receiver for Linux for more information about
starting the client.
2. On the Connections menu, click New.
3. Click Server or Published Application.
4. Do one of the following:
•

For a server desktop, type the name or IP address of the server or click Browse to
select from a list of servers.

For a published application, type the name of the published application or click
Browse to select from a list of published applications.
5. If you type the name of the server or published application, type a unique description
for the entry in the Description box. The description is used to identify the connection
in the Connection view. If you select a server or published application from the list, a
default description is added automatically.
•

6. Click OK to save the entry. Alternatively, to save your changes but retain the current
page, click Apply.
After you create a connection entry with the appropriate network connection
properties set up, the description appears in the Connection view.
Note: This is the simplest way to create a connection entry. When you follow these
steps, you set the essential items you need to connect to the server from the
workstation. You can change some of the other properties for a connection; for
example, the window size or color settings. See Changing the Window Properties.
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Viewing Connection Entries
By default, the main client window displays the Connection view, which lists all the
connection entries created by a user, including connections to published applications and
server desktops. Immediately after installing the client, this list may be empty.
The Connection view, which lists the connection entries users create, by description and
server name

If users want to view the connections that are set up automatically to applications and
content published on a XenApp Services site, they can do so using the Citrix XenApp view.

To view the published resources on a server running
the Web Interface
On the View menu, click Citrix XenApp View and log on if prompted.
A list of resources on the server appears:

Citrix XenApp view, which lists the published resources available to the user, by name and
type
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Viewing Connection Entries

As part of the publication process, only those resources defined for the client user appear.
A down arrow indicates a folder containing other published resources. When navigating
resources in a folder, an up arrow indicates the parent folder.
For more information about the publication process, see the XenApp or XenApp for UNIX
documentation.

To view the connections that were created from the
client
On the View menu, click Connection View.
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Opening a Connection
Users can connect to servers in a number of ways:

•

From the Connection view

•

Using Citrix XenApp (only for connections to published resources):
•

From the Citrix XenApp view

•

From menu items created by Citrix XenApp

From desktop items created by Citrix XenApp (often these are located in a folder
called "Citrix" or "Citrix delivery center")
From a command line
•

•

•

From a Web browser

To open a connection from the Connection view
1. Select the name of the connection you want to open.
2. Do one of the following:
•

On the Connections menu, click Connect.

•

Click the Connect button on the toolbar.

To open an application from the Citrix XenApp view
1. In the Citrix XenApp view, select the application to which you want to connect.
2. Do one of the following:
•

On the Citrix XenApp menu, click Connect.

•

Click the Connect button on the toolbar.

To open a connection from a command line
At a command prompt, type:
/usr/lib/ICAClient/wfica -desc “description”
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Opening a Connection
where description is the full text from the Description box of the connection entry. If the
description contains spaces, enclose it in quotation marks in the standard manner for Linux.
Note: If users cannot connect to a server, administrators may need to change the server
location or SOCKS proxy details. See Configuring ICA Browsing and Connecting Through a
Proxy Server for details.

To open a connection using a Web browser
If you are using Firefox, Mozilla, or Netscape, Web browser configuration to enable ICA
session connection is normally carried out automatically during installation.
If you need to set up .mailcap and MIME files for Firefox, Mozilla, or Netscape manually, use
the following file modifications so that .ica files start up the client executable, wfica. To
use other browsers, you need to modify the browser configuration accordingly.
1. For the .mailcap file modification, in $HOME, create or modify the .mailcap file and
add the line:
application/x-ica; /usr/lib/ICAClient/wfica.sh %s;
x-mozilla-flags=plugin:Citrix ICA
2. For the MIME file modification, in $HOME, create or modify the .mime.types file and
add the line:
application/x-ica ica
The x- in front of the format ica indicates that ica is an unofficial MIME type not
supported by the Internet Assigned Numbers Authority (IANA).
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Managing Your Connections
Users can control and investigate connections with the Connection Center. This feature
enables users to:
•

Close applications

•

Log off or disconnect from sessions

•

Manage connection windows

•

View connection transport statistics for sessions

The Connection Center is a useful productivity tool that enables users and administrators to
troubleshoot slow or problematic connections. Users can also use it to minimize and restore
their connection windows.

To access the Connection Center
On the Tools menu, click Connection Center.
The active sessions are listed and a summary of all the connections, showing the total
number of servers and applications in use, appears at the bottom of the Connection Center
dialog box.

To manage a connection window
In the Connection Center, select a session from the list and choose from the following
tasks.
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To

Click

End the selected session and close any
open applications

Logoff

Refresh the list of sessions and remove any
closed applications

Refresh

Display the Connection Center Status
dialog box, which contains statistics for
the selected session

Properties

Cut the selected connection to the server
without closing any open applications
(unless the server is configured to close
applications on disconnection)

Disconnect

Managing Your Connections
Close the selected application

Terminate

Minimize the window used by the selected
application or session

Iconify

Display the window used by the selected
application or session

Restore

To view information about a session
1. On the Tools menu, click Connection Center.
2. Select a session and click Properties. The Connection Center Status dialog box displays
the following information:

Box

Description

Connected to server

Server used for the connection. You can
specify the server by clicking Connections
> Properties and selecting the Network
page.

as user

Account used to log on to server.
“Anonxxx” indicates an anonymous
connection. You can specify the account by
clicking Connections > Properties and
selecting the Login page.

Encryption Level

Type of encryption. You can specify the
encryption level by clicking Connections >
Properties and selecting the Connection
page.

Client Version

Client version number.

Bytes

Number of incoming or outgoing bytes
transported along the connection.

Frames

Number of incoming or outgoing frames
transported along the connection.

Bytes/Frame

Number of bytes divided by number of
frames.

Frame errors

Number of incoming or outgoing frames
that were incorrectly transported along the
connection.
These statistics are available only for sessions, not published applications. However, if the
published application is the only connection within a session, the details displayed when
you select this session from the Connection Center apply to the published application.
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Configuring Connections
This section describes how administrators can configure connections between the Citrix
Receiver for Linux and XenApp servers. It covers both changing the default settings for all
connections, and changing the settings for individual connections.
It also contains procedures that support typical tasks performed by users of the client.
Although the tasks and responsibilities of administrators and users can overlap, the term
“user” is employed in this chapter to distinguish typical user tasks from those typically
performed by administrators.
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Customizing the Client Using
Configuration Files
You can update many common client settings using the user interface. To change more
advanced or less common settings, you can modify the client configuration files. These
configuration files are read each time you launch a connection. You can update various
different files depending on the effect you want the changes to have.
Important: From Version 10.x of the client, for each entry in appsrv.ini and wfclient.ini,
there must be a corresponding entry in All_Regions.ini for the setting to take effect. In
addition, for each entry in the [Thinwire3.0], [ClientDrive], and [TCP/IP] sections of
wfclient.ini, there must be a corresponding entry in canonicalization.ini for the setting to
take effect. See the All_Regions.ini and canonicalization.ini files in the $ICAROOT/config
directory for more information.
Applying changes to all users of the client. If you want the changes to apply to all users of
a client installation, modify the module.ini configuration file in the $ICAROOT/config
directory.
Applying changes to new users of the client. If you want the changes to apply to all future
new users of the client, modify the configuration files in the $ICAROOT/config directory.
For changes to apply to all connections, update wfclient.ini in this directory. For changes to
apply to specific connections, modify appsrv.ini in this directory. These files are copied to
new users’ $HOME/.ICAClient directories when they first start the client, if the files do not
exist there already.
Applying changes to specific connections for particular users. If you want the changes to
apply to a specific connection for a particular user, modify the appsrv.ini file in that user’s
$HOME/.ICAClient directory. This file contains a section for each connection the user set
up.
Applying changes to all connections for particular users. If you want the changes to apply
to all connections for a particular user, modify the wfclient.ini file in that user’s
$HOME/.ICAClient directory. The settings in this file apply to both existing and future
connections for that user.
Validating configuration file entries. If you want to limit the values for entries in
appsrv.ini and wfclient.ini, you can specify allowed options or ranges of options in
All_Regions.ini. See the All_Regions.ini file in the $ICAROOT/config directory for more
information.
Note: If an entry appears in more than one configuration file, a value in appsrv.ini takes
precedence over a value in wfclient.ini, which in turn takes precedence over a value in
module.ini.
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Configuring Default Connection Settings
This section describes how to configure settings that apply to all connection entries on the
workstation. These settings are also used as defaults for any new connections that users
create. You may want, for example, to customize the default window size if you prefer all
new connections to appear in larger or smaller windows than the original setting.
To change the default settings
On the Tools menu, click Settings. The Settings dialog box has pages corresponding to the
properties you can control including:

42

•

The Preferences page, where you specify the settings for keyboard options, alert
sounds, and digital dictation support that apply to all connection entries. See
Configuring Keyboard Options, Alert Sounds, and Digital Dictation Support.

•

The Window page, where you specify the window settings to use for all new connection
entries. See Configuring Default Window Properties.

•

The Server Location page, where you specify the server address for the server that will
report the data collector. See Configuring ICA Browsing.

•

The Keyboard Shortcuts page, where you define alternative key combinations for
system keyboard shortcuts. See Configuring Keyboard Shortcuts.

•

The Disk Cache page, where you define settings for the disk cache. See Configuring
Disk Cache Settings.

•

The Drive Mapping page, where you set up drive mappings. See Mapping Client Drives.

•

The COM Ports page, where you configure COM port mapping. See Mapping COM Ports.

•

The Firewall page, where you configure firewalls and a SOCKS proxy. See Connecting
through a Proxy Server.

•

The Auto Reconnect page, where you specify settings for HDX Broadcast auto-client
reconnect. See Configuring HDX Broadcast Auto-Client Reconnect.

•

The Citrix XenApp page, where you identify the server running the XenApp Services
site. See Configuring Citrix XenApp.

•

The Secure Gateway page, where you can specify a Secure Gateway relay server for
the client to use when connecting to the server. See Using the Secure Gateway or Citrix
SSL Relay.

Configuring Keyboard Options, Alert
Sounds, and Digital Dictation Support
To configure the preference settings
1. On the Tools menu, click Settings.
2. From the drop-down list, choose Preferences to display the Preferences page.
3. Adjust the settings as required, for example:
In the Keyboard Layout box, click Browse to select your input locale from the list.
Input locale is the language in which you want to type. If you select User Profile,
the server chooses the input locale.
•

In the Keyboard Type (Client) box, click Browse to select your correct workstation
keyboard type from the list.
Note: If you are using a Sun keyboard, by default the left Meta key acts as a
Windows key, and the right Meta key acts as a Menu key. The Meta keys are
marked with a diamond.

•

In the Keyboard Type (Server) box, click Browse to select the specific physical
keyboard type you are using from the list. If you are using a Japanese keyboard,
select it. For all others, use the default (standard 105 key keyboard).

•

Select Enable Windows Alert Sounds if you want Windows alert sounds to be
played using the client device sound system.

•

Select Allow Audio Input to enable support for client-side microphone input. See
Configuring Digital Dictation Support.
Note: You must select Allow Audio Input if you want to configure digital
dictation support for individual connections.
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Configuring Default Window Properties
Use the Window page in the Settings dialog box to set up the default window settings for
all new connection entries. If you want to change the window settings for a specific
connection, see Changing the Window Properties.
To configure the default window settings
1. On the Tools menu, click Settings.
2. From the drop-down list, choose Window to display the Window page.
3. Adjust the settings as required, for example:
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•

Default Window Size enables you to select from Fixed Size, Percentage of Screen
Size, or Full Screen.

•

Default Window Colors enables you to set the number of window colors to 16, 256,
32 Thousand, 16 Million, or Automatic. Automatic enables the client to select the
best available color depth for the connection. Before selecting a new color mode,
ensure that it is supported on your computer.

•

Default 256 Color Mapping enables you to set up 256 color sessions to use
approximate or exact colors. If you select Private - Exact Colors, the client will use
a private colormap on PseudoColor displays to display the exact colors sent by the
server. This may, however, cause color flashing when moving between windows. To
avoid this, use Shared - Approximate Colors to eliminate color flashing when
switching context. Note that if other applications allocate all 256 colors, the client
may use a private colormap.

Configuring a Default Network Protocol
The Network Protocol setting enables you to control the way the client searches for servers
and how it communicates with them.
To configure a default network protocol
1. In the Connection view, select Settings from the Tools menu.
2. From the drop-down list, choose Server Location to display the Server Location page.
3. Select your required network protocol from the Network Protocol list.
4. Click OK.

45

Configuring ICA Browsing
ICA browsing (also called server location) is the mechanism by which a client discovers an
appropriate server to host a given application. The way in which browsing works depends on
which network protocol is configured.
TCP/IP+HTTP and SSL/TLS+HTTPS. The default server address is ica. When ICA browsing,
the client searches for ica.domainname, where domainname is one of the default domain
names configured for the client. This feature enables the Domain Name Server (DNS)
administrator or Windows Internet Naming (WINS) administrator to configure a host record
that maps “ica” to the address of the data collector. For example, when a client sends a
request for an application, the data collector responds with the address of a server on
which the application is published. The client uses the HTTP or HTTPS protocol to contact
servers.
TCP/IP. The default setting for server location is auto-locate. The client attempts to
contact all of the servers on the subnet by broadcasting on the UDP protocol. Alternatively,
you can set a specific address for the server that functions as the data collector.
You can define up to three groups of servers to contact for ICA browsing: a primary and two
backups. Each group can contain from one to five servers. The client attempts to contact
each of the servers in turn.
To configure ICA browsing
1. On the Tools menu, click Settings.
2. From the drop-down list, choose Server Location to display the Server Location page.
3. Select the required network protocol from the Network Protocol list.
4. Select the required server group from the Server Group list.
5. Click Add to display the Add Server Location Address dialog box.
6. Enter the name or IP address of a server. For the TCP/IP+HTTP and SSL/TLS+HTTPS
protocols, if you do not enter an IP address, you must have a server on your network
mapped to the default name of ica.domainname, where domainname is one of the
default domain names configured for the client. TCP/IP+HTTP and SSL/TLS+HTTPS
server location do not support the (Auto-Locate) function.
7. To define other server groups, select the required group from the Server Group list and
repeat Steps 5 and 6.
8. Click OK.
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Configuring Keyboard Shortcuts
Alternative keyboard shortcuts are used to control the behavior of the client and as
substitutes for the standard Windows keyboard shortcuts for a published application. For
example, if you want to close the current window on a Windows PC, you press ALT+F4. This
key combination also closes a window in X Windows. Keyboard shortcut functionality
enables you to map common key combinations like ALT+F4 to a key combination such as
ALT+CTRL+F4 that is ignored by your local operating system. When you press this new
combination, the client sends ALT+F4 to the server, closing the current window on the
server.
If a keyboard shortcut includes plus or minus signs, use the numeric keypad to enter these
signs instead of the main keypad to ensure the shortcut works correctly.
To configure the keyboard shortcut settings
1. On the Tools menu, click Settings.
2. From the drop-down list, choose Keyboard Shortcuts to display the Keyboard
Shortcuts page.
3. Select whether you want the key combinations to apply locally or remotely by choosing
an option from the Handling of keyboard shortcuts drop-down list:
Note: It might be necessary to set your client keyboard type to LINUX to pass the
keyboard shortcuts to remote sessions. See Configuring Keyboard Options, Alert
Sounds, and Digital Dictation Support for information about configuring the keyboard
type.

•

Translated applies keyboard shortcuts to the local desktop rather than the remote
desktop. For example, pressing ALT+TAB switches between all the windows
currently open on the local desktop, including both local and remote windows.
Direct applies keyboard shortcuts to the remote desktop rather than the local
desktop. For example, pressing ALT+TAB switches between all the windows
currently open on the remote desktop, excluding any windows open on the local
desktop.
If you select Direct, keyboard shortcut translations are disabled to ensure that the
keystrokes are applied to the remote desktop.
Direct in full screen desktops only applies keyboard shortcuts to the remote
desktop rather than the local desktop when the remote session is running in full
screen mode. If the session is running in any other window size mode, keyboard
shortcuts are applied to the local desktop rather than the remote desktop.

If you select Direct in full screen desktops only and the remote session is running
in full screen mode, keyboard shortcut translations are disabled to ensure that the
keystrokes are applied to the remote desktop.
4. Adjust the keyboard shortcut settings as required:
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Configuring Keyboard Shortcuts
•

You can define alternative key combinations for the keyboard shortcuts ALT+F1 to
ALT+F12, ALT+TAB, and ALT+SHIFT+TAB, which are reserved for use by X Windows.
By default, these key combinations are generated by CTRL+SHIFT+F1 to
CTRL+SHIFT+F12, ALT+MINUS SIGN, and ALT+SHIFT+PLUS SIGN, but you can change
the definitions by selecting alternative keys from the pop-up menus.
If you select a key combination for a shortcut, this particular combination appears
dimmed on the pop-up menus for the other shortcuts.
•

Any ALT key combinations not used by your X Window manager can be used as
normal within the ICA session.

•

You can define an additional combination for Toggle SpeedScreen (default
SHIFT+F12). This enables you to turn SpeedScreen Local Text Echo on and off within
a session. For more information about SpeedScreen settings see SpeedScreen
Latency Reduction.

•

You can also define a key combination to switch off remote key handling (default
CTRL+F2). If a remote desktop is running in full screen mode, it is possible to lose
control of the local desktop because all keystrokes are applied remotely. This key
sequence temporarily applies keyboard shortcuts to the local desktop, until the
remote window regains focus.

Note: If you want to use the PC key combination CTRL+ALT+DELETE during the
session, use the key combination CTRL+ALT+ENTER or CTRL+ALT+RETURN.
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Configuring Disk Cache Settings
Use the Disk Cache page in the Settings dialog box to control the location, size, and
contents of the disk cache.
Note: The disk cache is used only if it is enabled for a particular connection. See
Improving Performance over a Low-Bandwidth Connection for details.
To adjust the settings for the disk cache
1. On the Tools menu, click Settings.
2. From the drop-down list, choose Disk Cache to display the Disk Cache page.
3. Select the settings you require. You can:
•

Set the maximum size of the cache by adjusting the Bitmap Cache Size value.

•

Change the location of the cache by clicking the Change button and browsing to
your desired location for the Disk Cache Directory. If you change the location of a
cache on a workstation, make sure that you clear the old cache first.

•

Set the minimum size of bitmaps to cache by adjusting the The minimum size
bitmap that will be cached is slider. The size setting appears next to the slider.

•

Clear the cache by clicking the Clear Cache Now button. Citrix recommends that
you do not clear the cache if any server connections are open. Before clearing the
cache, verify that all server connections are closed.

Note: An administrator can view information about the bitmap cache settings for a
server connection using the Client Cache tab in the Access Management Console.
For more information, see the XenApp documentation.
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Configuring HDX Broadcast Auto-Client
Reconnect
HDX Broadcast auto-client reconnect enables dropped ICA sessions to be reestablished
automatically without users having to reconnect manually or reenter credentials. It is
enabled on the client by default; no configuration is required on the client device to use
these default settings.
For more information about how auto reconnect works and for information about changing
the auto reconnect settings for an individual connection, see Changing HDX Broadcast
Auto-Client Reconnect Settings.
To change the HDX Broadcast auto-client reconnect default settings
1. On the Tools menu, click Settings.
2. From the drop-down list, choose Auto Reconnect to display the Auto Reconnect page.
3. Select the Enable Auto Reconnect check box.
4. Enter values for Maximum Retries and Seconds Delay Before Retrying Reconnect.
5. Click OK.

50

Configuring Individual Connection
Settings
This section describes how to change properties for an individual connection entry.
To change the properties for a connection entry
1. In the Connection view, select the connection entry that you want to change.
2. On the Connections menu, click Properties. The Properties dialog box has pages
corresponding to the properties you can control, including:
•

The Network page, where you can change the settings required to establish a
connection with the server. See Configuring Network Properties.

•

The Connection page, where you can control the connection between the server
and client; for example, to improve performance by reducing bandwidth. See
Improving Performance over a Low-Bandwidth Connection. You can also use the
Connection page to configure middle button paste functionality and digital
dictation support. See Configuring Middle Button Paste Functionality and
Configuring Digital Dictation Support.

•

The Firewall page, where you can specify proxy server settings. See Connecting
through a Proxy Server.

•

The Window page, where you can specify the window size and number of colors
used for the ICA session. See Changing the Window Properties.

•

The Application page, where you can specify an application to run when you
connect to the server. See Specifying an Application to Run at Connection.

•

The Login page, where you can specify your logon details so that you do not have to
type them each time you connect to a server. See Configuring Logon Properties.

•

The Auto Reconnect page, where you specify settings for HDX Broadcast
auto-client reconnect. See Changing HDX Broadcast Auto-Client Reconnect Settings.

•

The Secure Gateway page, where you can specify a Secure Gateway relay server
for the client to use when connecting to the server. See Using the Secure Gateway
or Citrix SSL Relay.

•

The File Associations page, where you can link file types with particular
applications. See Configuring File Type Associations.

Note: The File Associations option is not visible by default. You must reconfigure the
client to make this option visible. See Configuring File Type Associations for
information about making this option visible.
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Configuring Network Properties
Use the Network page in the Properties dialog box to specify a connection with a server
and the network protocol to use.
To change the network properties for a connection entry
1. In the Connection view, select the connection entry that you want to change.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Network to display the Network page.
4. Adjust the properties as required:

52

•

Enter a description of the connection in the Description box.

•

To configure a connection to a server, click Server. To configure a connection to a
published application, click Published Application. You can specify a server either
by its name or its IP address. To get a list of servers or published applications, click
Browse.

•

To change the protocol used when locating the data collector, see Configuring ICA
Browsing.

Improving Performance over a
Low-Bandwidth Connection
If users are using ICA over a low-bandwidth connection, such as a modem or cellular
telephone, they can make a number of changes to their client configuration and the way
they use the client to improve performance.
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•

Change the client configuration. Changing the configuration of the client can reduce
the bandwidth that ICA requires and improve performance.

•

Change how the client is used. Changing the way the client is used can also reduce the
bandwidth required for a high-performance connection.

•

Use the latest versions of XenApp and the Citrix Receiver for Linux. Citrix
continually enhances and improves ICA performance with each release, and many
performance features require the latest client and server software.

Changing the Client Configuration
On devices with limited processing power or where limited bandwidth is available, there is
a trade-off between performance and functionality. The clients provide both user and
administrator with the ability to choose an acceptable mixture of rich functionality and
interactive performance. Making one or more of these changes can reduce the bandwidth
that a connection requires and improve performance.
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Enabling the Disk Cache
Disk caching stores commonly used bitmaps (images) locally on the client device so that the
bitmaps are not transferred over the server connection every time they are needed.
To enable disk caching
1. In the Connection view, select the connection entry that you want to change.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Connection to display the Connection page.
4. Select Use Disk Cache for Bitmaps.
5. Click OK. You can enable or disable bitmaps for each connection entry so that you can
control the connection to each server. Only one physical cache is used for all
connection sessions that are enabled. See Configuring Disk Cache Settings.
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Data Compression
Data compression reduces the amount of data transferred across the ICA connection. This
requires additional processor resources to compress and decompress the data, but it can
increase performance over bandwidth-limited connections.
To enable data compression
1. In the Connection view, select the connection entry that you want to change.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Connection to display the Connection page.
4. Select Use Data Compression to reduce the amount of data transferred across the ICA
session.
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SpeedScreen Latency Reduction
SpeedScreen latency reduction improves performance over high latency connections by
providing instant feedback to the user in response to typed data or mouse clicks.
Note: SpeedScreen latency reduction works only if it is available on the server that you
are connecting to and only if it is enabled. For more information, se the XenApp
documentation.
To change SpeedScreen latency reduction settings
1. In the Connection view, select the connection entry that you want to change.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Connection to display the Connection page.
4. In the SpeedScreen section there are two list boxes: Local Text Echo and Mouse Click
Feedback. Local Text Echo accelerates display of the input text, effectively shielding
you from experiencing latency on the network. Mouse Click Feedback provides visual
feedback of a mouse click, in that the mouse pointer immediately changes to an
hourglass indicator. Select a mode for each from the drop-down lists:
•

For slower connections (for example if you are connecting over a WAN or a dial-in
connection), set mode to On to decrease the delay between user input and screen
display.

•

For faster connections (for example, if you are connecting over a LAN), set mode to
Off.

•

If you are not certain of the connection speed, set the mode to Auto to turn
SpeedScreen on or off depending on the latency of the connection. You can
override Auto mode using the Toggle SpeedScreen keyboard shortcut.

Note: Local text echo does not support input using an Input Method Editor.
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Reducing the Window Size
Reduce the amount of bandwidth used by changing the window size to the minimum you
can comfortably use. See Configuring Default Window Properties for more information
about changing the window size for all connections, or see Changing the Window Properties
for more information about changing the window size for a specific connection.
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Modifying the Color Depth
Reducing or increasing color depth can improve performance. See Configuring Default
Window Properties for more information about changing the color depth for all connections,
or see Changing the Window Properties for more information about changing the color
depth for a specific connection.
The color depth required to achieve optimum performance varies between applications; for
example, applications such as Microsoft Word and Internet Explorer that assemble their
screen image off screen use less bandwidth when color depth is increased up to a maximum
of 32 thousand colors.
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Reducing Sound Quality
If you are using sound, reduce the sound quality to the minimum setting or disable client
audio mapping. See Mapping Client Audio for more information.
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Changing How the Client Is Used
ICA technology is highly optimized and typically does not have high CPU and bandwidth
requirements. However, if you are using a very low-bandwidth connection, consider the
following to preserve performance:
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•

Avoid accessing large files using client drive mapping. When you access a large file
with client drive mapping, the file is transferred over the server connection. On slow
connections, this may take a long time.

•

Avoid printing large documents on local client printers. When you print a document
on a local client printer, the print file is transferred over the server connection. On
slow connections, this may take a long time.

•

Avoid playing multimedia content. Playing multimedia content uses a lot of bandwidth
and can cause reduced performance.

Improving Multimedia Performance
HDX Mediastream Multimedia Acceleration overcomes the need for the high-bandwidths
required to provide multimedia capture and playback on virtual Windows desktops running
on Linux user devices. HDX Mediastream Multimedia Acceleration provides a mechanism for
playing the media run-time files on the endpoint rather than on the server, thereby
reducing the bandwidth requirements for playing multimedia files.
HDX Mediastream Multimedia Acceleration improves the performance of Windows Media
player and compatible players running on virtual Windows desktops. A wide range of file
formats are supported, including:
•

Advanced Systems Format (ASF)

•

Motion Picture Experts Group (MPEG)

•

Audio-Video Interleaved (AVI)

•

MPEG Audio Layer-3 (MP3)

•

WAV sound files

To implement this feature, you must install GStreamer, an open-source multimedia
framework, on each client that requires multimedia acceleration. Typically, you install
GStreamer before you install the client software. This enables you to select the GStreamer
option during the installation to ensure that multimedia acceleration is integrated into the
client software. For more information see HDX Mediastream Multimedia Acceleration.
You can download GStreamer from http://gstreamer.freedesktop.org.
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Configuring Middle Button Paste
Functionality
You can make Windows applications running on the server behave more like UNIX
applications by configuring the client to enable middle button paste functionality.
To configure middle button paste functionality
1. In the Connection view, select the connection entry for which you want to enable
middle button paste.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Connection to display the Connection page.
4. Select the Enable Middle Button Paste check box.
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Configuring Digital Dictation Support
XenApp supports client-side microphone input. This enables you to publish dictation
software for use in client sessions. Using local microphones, users can record dictations
with applications running on the server.
For example, a user away from the office can establish a client session to record notes
using a laptop. Later in the day the user can retrieve the notes for review or transcription
from the desktop device back at the office.
For information about configuring this feature on the server, see the XenApp
documentation.
Important: Before configuring digital dictation support for a connection, confirm that the
Allow Audio Input check box is selected on the Preferences page of the Settings dialog
box.
To configure digital dictation support for a connection entry
1. In the Connection view, select the name of the connection for which you want to
configure digital dictation support.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Connection to display the Connection page.
4. Select the Enable Audio Input check box and the Enable Sound check box.
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Changing the Window Properties
You can change the window size, number of colors, and color mapping used for a particular
connection.
To change the window properties
1. In the Connection view, select the connection entry you want to change.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Window to display the Window page.
Window Size enables you to select from Fixed Size, Percentage of Screen Size, or
Full Screen. Select Fixed Size or Percentage and type the size (in pixels) or
percentage in the Window Size boxes. If you are connecting to a published
application, you can also select Seamless. Seamless integrates local and remote
windows on the desktop. Note that seamless connections to published desktops are
not supported.
Note: Because clients support seamless windows natively, it is not necessary to
use “pass-through” mode. Pass-through mode is intended to facilitate seamless
windows for clients that do not support seamless windows natively, and should
only be used from a fixed-size window session on the client device. Note that
“seamless within seamless” (that is, seamless windows in pass-through mode) is
not a supported configuration.
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•

Window Colors enables you to set the number of window colors to 16, 256, 32
Thousand, 16 Million, or Automatic. Automatic enables the client to select the
best available color depth for the connection. Your display must be capable of
displaying the resolution and color depth you select.

•

256 Color Mapping enables you to set up 256 color sessions to use approximate or
exact colors. If you select Private - Exact Colors, the client uses a private colormap
on PseudoColor displays to display the exact colors sent by the server. This may,
however, cause color flashing when moving between windows. To avoid this, use
Shared - Approximate Colors. Note that if other applications allocate all 256
colors, the client may use a private colormap.

•

In each case, select Use Default to use the default window size or window colors
setting. For more information about setting defaults, see Configuring Default
Window Properties.

Specifying an Application to Run at
Connection
You can specify an application to run automatically when you connect to a server. If you
specify an application, you do not see the desktop of the server when you connect and the
connection is closed when you exit the application.
To specify an application to run at connection
1. In the Connection view, select the connection entry that you want to change.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Application to display the Application page.
•

In the Application box, specify the pathname of an application to be run after
connecting to a server

•

In the Working Directory box, specify the pathname of a directory to be used with
the application

Note: If the entry you are configuring is a connection to a published application, the
Application page is not available.
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Configuring Logon Properties
You can store the logon details for your server connection so that you do not need to type
them each time you connect.
To configure logon properties
1. In the Connection view, select the connection entry that you want to change.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Login to display the Login page.
4. Type your Username and Domain (optional) for the connection. Although you can also
provide your password, for security reasons it is not good practice to configure the
connection in this way. Instead, it is better to type your password when establishing the
connection.
5. To enable smart card logon, select Allow Smart Card Logon. For more information
about using smart cards with clients, see Enabling Smart Card Support.
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Changing HDX Broadcast Auto-Client
Reconnect Settings
ICA sessions can be dropped because of unreliable networks, highly variable network
latency, or range limitations of wireless devices. HDX Broadcast auto-client reconnect is
triggered when a client detects a disconnected session. When this feature is enabled on
servers, users do not have to reconnect manually or reenter logon credentials to continue
working. Automatic reconnection does not occur if users exit applications.
When a reconnection sequence begins, the user is informed that the client will reconnect
after a set interval. Reconnection requires no action by users, although they can choose to
cancel the process or reconnect immediately. Because session drops may be caused by
network instability, users must wait a few moments before reconnecting to give the
network time to recover from the problem that caused the disconnection.
When the client detects that its connection to the server is unexpectedly broken, it waits
for a maximum of 36 seconds before beginning the reconnection sequence. By default, the
client attempts to reconnect three times and then, if unsuccessful, it stops. To change the
default number of attempts, or other HDX Broadcast auto-client reconnect default settings,
see Configuring HDX Broadcast Auto-Client Reconnect.
To change the HDX Broadcast auto-client reconnect settings for a connection entry
1. In the Connection view, select the connection entry that you want to change.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Auto Reconnect to display the Auto Reconnect page.
4. Select Enable Auto Reconnect and, if required, enter values for Maximum Retries and
Seconds Delay Before Retrying Reconnect.
5. Click OK.
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Configuring File Type Associations
Drag and drop support enables users to open files without knowing which application is
needed. The client uses file type association to determine which application on the server
to use with particular file types, and automatically opens the associated application. The
Citrix Receiver for Linux enables administrators to set this up from the File Associations
option in the Properties drop-down list as described in this section.
File type associations can be either dynamic (received from the XenApp Services site), or
static (configured on the File Associations page of the Properties dialog box). For
information about configuring the client to use dynamic or static file type associations, see
To configure the client to use static or dynamic file type associations.
Note: If a user tries to open a file using dynamic file type associations while not logged
on to a server, a logon prompt is displayed. If the user cancels the logon, the application
launch is also cancelled.
By default, file type associations are dynamic, but if your environment does not have a
XenApp Services site you can set up static file type associations on the client. These file
type associations persist between sessions. For information about setting up static file type
associations, see To set up static file type associations.
Dropped files must reside on a mapped file system to enable the server to access them.
Users can drop files onto the main client window, the client manager icon, or onto another
desktop icon, with the following results:

•

Dropping files onto the main client window. In most cases, if a user drops a file onto
the main client window, the file type associations determine which application to open.
However, certain types of files are treated differently. If an .ica file is dropped onto
the client window, the client makes the connection specified in the file, while if a
.pnagent file or a .desktop file is dropped on the client window, the client launches the
application specified in the file.
Dropping files onto the client manager icon. If a user drops an .ica file onto the client
manager icon, the client makes the connection specified in the file. If other file types
are dropped onto the client manager icon, the file type associations determine which
application to open.
Note: This functionality is not available if you are using the GNOME desktop
environment.

•

Dropping files onto another desktop icon. If a user drops a file onto another desktop
icon, the client responds only if the icon corresponds to a Citrix published resource. For
published application icons, the client always uses dynamic file type associations to
check whether the file type is supported by the application. If so, the client opens the
file using the selected application. If not, the user is asked whether to continue
opening the chosen application. For published content icons, the user is advised that
the icon is not an application, and the client offers the option of opening the file with a
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suitable application.
Note: This functionality is not available if you are using the GNOME desktop
environment.

To configure the client to use static or dynamic file
type associations
1. Choose and open a configuration file according to which users you want your changes to
affect. See Customizing the Client Using Configuration Files for information about how
updates to particular configuration files affect different users.
2. In the [WFClient] section of the file, set the value for
UseDynamicFileTypeAssociation. False makes the File Associations option
visible in the Properties drop-down list and sets the client to use static file type
associations, and True sets the client to use dynamic file type associations.
Note: If this line does not appear in either wfclient.ini or module.ini, the client uses
static file type associations.
3. Save and close the file.

To set up static file type associations
1. On the View menu, click Connection View to display the available connections.
2. Select the connection for which you want to set up file associations.
3. On the Connections menu, click Properties.
4. From the drop-down list, choose File Associations to display the File Associations
page. Click Add.
Note: If the File Associations option is not visible, see To configure the client to use
static or dynamic file type associations for information about displaying this option.
5. Select the required application and file type combination from the list and click OK.
Note: A file type cannot be associated with more than one published application.
However, you can associate more than one file type with a single application.
6. Click OK.
7. Ensure that the published application and file type are associated for content
redirection. For more information, see the XenApp documentation.
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Configuring Special Folder Redirection
In this context, there are only two special folders for each user:

•

The user’s Desktop folder

•

The user’s Documents folder (My Documents on Windows XP)

Special folder redirection is a feature that enables you to specify the locations of a user’s
special folders so that these remain fixed across different server types and server farm
configurations. This is particularly important if, for example, a mobile user needs to log on
to servers in different server farms. For static, desk-based workstations, where the user can
log on to servers that reside in a single server farm, special folder redirection is rarely
necessary.

To configure special folder redirection
This is a two-part procedure. First, you enable special folder redirection by making an entry
in module.ini; then you specify the folder locations in wfclient.ini, as described here:
1. Add the following text to module.ini (for example, $ICAROOT/config/module.ini):
[ClientDrive]
SFRAllowed = True
2. Add the following text to wfclient.ini (for example, $HOME/.ICAClient/wfclient.ini):
DocumentsFolder = documents
DesktopFolder = desktop
where documents and desktop are the UNIX filenames, including the full path, of the
directories to be used as the users’s Documents folder and Desktop folder respectively.
For example:
DesktopFolder = $HOME/.ICACLIENT/desktop
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•

You can specify any component in the path as an environment variable, for example,
$HOME.

•

You must specify values for both parameters.

•

The directories you specify must be available through client device mapping; that is,
the directory must be in the subtree of a mapped client device.

Configuring Special Folder Redirection
•
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You must use the drive letters “C” or higher.

Configuring ClearType Font Smoothing
ClearType font smoothing—also known as Sub-pixel font rendering—improves the quality of
displayed fonts beyond that available through traditional font smoothing or anti-aliasing.
You can turn this feature on or off, or specify the type of smoothing by editing the
configuration file wfclient.ini.
The entry for font smoothing takes the form:
FontSwitchingType = number
where number can take one of the following values:
0 or 1

No smoothing

2

Standard smoothing

3
ClearType (horizontal sub-pixel) smoothing
Both standard smoothing and ClearType smoothing increase the client’s bandwidth
requirements significantly.
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Integrating the Citrix Receiver for Linux
with KDE and GNOME
During installation, you can choose to integrate the client into the K Desktop Environment
(KDE) and the GNU Network Object Model Environment (GNOME). If KDE or GNOME is
present, client installations create a menu option from which users can start the client.
The menu entries and desktop shortcuts are created dynamically by Citrix XenApp.
Note: For best operation, set $ICAROOT in $HOME/.profile or $HOME/.bash_profile,
unless the client is installed in the default location.
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Setting up Server-Client Content
Redirection
Server-client content redirection enables administrators to specify that URLs in a published
application are opened using a local application. For example, opening a link to a Web page
while using Microsoft Outlook in an ICA session opens the required file using the browser on
the client device. Server-client content redirection enables administrators to allocate Citrix
resources more efficiently, thereby providing users with better performance.
The following types of URL can be redirected:

•

HTTP (Hypertext Transfer Protocol)

•

HTTPS (Secure Hypertext Transfer Protocol)

•

RTSP (Real Player)

•

RTSPU (Real Player)

•

PNM (Older Real Players)

If the client does not have an appropriate application or cannot directly access the content,
the URL is opened using the server application.
Server-client content redirection is configured on the server and enabled by default on the
client provided that the path includes RealPlayer and at least one of Firefox, Mozilla, or
Netscape.
Note: RealPlayer for Linux can be obtained from
http://proforma.real.com/real/player/unix/unix.html.
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To enable server-client content redirection if
RealPlayer and a browser are not in the path
1. Open the configuration file wfclient.ini.
2. In the [Browser] section, modify the following settings:
Path=path
Command=command
where path is the directory where the browser executable is located and command is
the name of the executable used to handle redirected browser URLs, appended with
the URL sent by the server. For example:
$ICAROOT/nslaunch netscape,firefox,mozilla
This setting specifies the following until content can be displayed successfully:
•

The nslaunch utility is run to push the URL into an existing browser window

Each browser in the list is tried in turn
3. In the [Player] section, modify the following settings:
•

Path=path
Command=command
where path is the directory where the RealPlayer executable is located and command is
the name of the executable used to handle the redirected multimedia URLs, appended
with the URL sent by the server.
4. Save and close the file.
Note: For both Path settings, you need only specify the directory where the browser
and RealPlayer executables reside. You do not need to specify the full path to the
executables. For example, in the [Browser] section, Path might be set to
/usr/X11R6/bin rather than /usr/X11R6/bin/netscape. In addition, you can specify
multiple directory names as a colon-separated list. If these settings are not specified,
the user's current $PATH is used.

To turn off server-client content redirection from the
client
1. Open the configuration file module.ini.
2. Change the CREnabled setting to Off.
3. Save and close the file.
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Using xcapture
The client includes a helper application, xcapture, that can assist the exchange of graphical
data between the server clipboard and non-ICCCM-compliant X Windows applications on the
X desktop. Users can use xcapture to:

•

Capture dialog boxes or screen areas and copy them between the client desktop
(including non-ICCCM-compliant applications) and an application running in a
connection window

•

Copy graphics between a connection window and X graphics manipulation utilities xmag
or xv

To start xcapture from the command line
At the command prompt, type /usr/lib/ICAClient/util/xcapture and press ENTER
(where /usr/lib/ICAClient is the directory in which you installed the client).

To start xcapture from the main client window
On the Tools menu, click xcapture.

To copy from the client desktop
1. From the xcapture dialog box, click From Screen. The cursor changes to a crosshair.
2. Choose from the following tasks:
•

Select a window. Move the cursor over the window you want to copy and click the
middle mouse button.

•

Select a region. Hold down the left mouse button and drag the cursor to select the
area you want to copy.

Cancel the selection. Click the right mouse button. While dragging, you can cancel
the selection by clicking the right button before releasing the middle or left mouse
button.
3. From the xcapture dialog box, click To ICA. The xcapture button changes color to show
that it is processing the information.
•

4. When the transfer is complete, use the appropriate paste command in an application
launched from the connection window.
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To copy from xv to an application in a connection
window
1. From xv, copy the information.
2. From the xcapture dialog box, click From XV and then click To ICA. The xcapture
button changes color to show that it is processing the information
3. When the transfer is complete, use the appropriate paste command in an application
launched from the connection window.

To copy from an application in the connection window
to xv
1. From the application in a connection window, copy the information.
2. From the xcapture dialog box, click From ICA and then click To XV. The xcapture
button changes color to show that it is processing the information
3. When the transfer is complete, paste the information into xv.

78

Mapping Client Devices
The client supports client device mapping for connections to servers. Client device mapping
enables a remote application running on the server to access devices attached to the local
user device. The applications and system resources appear to the user at the user device as
if they are running locally. Ensure that client device mapping is supported on the server
before using these features.
Note: Client device mapping, except for printers, is not supported when connecting to
Citrix MetaFrame for UNIX Operating Systems 1.0 and 1.1. Client printer mapping and,
with Hotfix 2, client drive mapping are supported when connecting to Version 1.1,
Feature Release 1 and later versions of Citrix XenApp for UNIX.
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Mapping COM Ports
You can perform bidirectional mapping of serial devices on the client device (for example,
/dev/ttyS0) to COM ports on the server. This enables a user at the client workstation to use
local devices such as modems, serial printers, and bar-code scanners seamlessly from the
applications running on the server.
To configure COM port mapping
1. On the Tools menu, click Settings.
2. From the drop-down list, choose COM Ports to display the COM Ports page.
3. To map a COM port, click Add.
4. In the Files list, click the name of the device for which you want to configure COM port
mapping.
5. Click OK.
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Mapping Client Drives
Client drive mapping makes any directory mounted on a client device, including a CD-ROM,
DVD or a USB memory stick, available to the user during ICA sessions. When a server is
configured to allow client drive mapping, users can access their locally stored files, work
with them during their ICA sessions, and then save them again either on a local drive or on
a drive on the server. For more information about controlling drive mapping on the server,
see the XenApp documentation.
On the client, two types of drive mapping are available:
Static client drive mapping enables administrators to map any part of the client filesystem
to a specified drive letter on the server at logon. So, for example, it can be used to map all
or part of a users home directory or /tmp, as well as the mount points of hardware devices
such as CD-ROMs, DVDs, or USB memory sticks.
Whereas, when dynamic client drive mapping is enabled, the directories in which hardware
devices such as CD-ROMs, DVDs and USB memory sticks are typically mounted on the client
are monitored and any new ones that appear during a session are automatically mapped to
the next available drive letter on the server.
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To specify drives and directories to map at logon
1. On the Tools menu, click Settings.
2. Choose Drive Mapping from the drop-down menu. For each drive letter, the Drive
Mapping list shows the disk or pathname of the client directory mapped to the drive. In
the Enable/Read/Write columns, icons display whether each mapped drive is enabled
for use and what type of access the user will have to the drive.
3. Select the check box in the Enable column next to an available drive letter and then
click the box for the drive.
4. Click Modify. A standard UNIX file selection dialog box appears. Select the UNIX
directory you want to map and click OK. Alternatively, you can simply type the
directory path in the box next to the required drive letter.
5. The mapped directory appears in the Drive Mapping list. If the drive letter you selected
is not available on the Windows server, the specified directory is mapped to another
free drive letter at logon. For more information about drive mapping, see the XenApp
documentation.
6. Specify the access for the drive by clicking the corresponding read/write icons. You can
use:
Icon

Meaning

(Pair of glasses)

Read access

(Pair of glasses, with question mark)

Prompt for read access on first access
per session

(Pair of glasses, obscured by cross)

No read access

(Pencil)

Write access

(Pencil, with question mark)

Prompt for write access on first access
per session

(Pencil, obscured by cross)
No write access
7. Ensure that Enable Drive Mapping is selected.
8. Click OK. Log off from any server connections already established and reconnect. The
same drive mapping and access settings will apply to all connection entries.
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To enable dynamic mapping of client drives during a
session
1. On the Tools menu, click Settings.
2. Choose Drive Mapping from the drop-down menu.
3. Select Enable Dynamic Drive Mapping.
4. Click OK.
Note: When dynamic client drive mapping is enabled, the Citrix Receiver for Linux
monitors the /media and /mnt/media directories for new mounts.

To view mapped client drives when connected to a
Windows server
1. From the ICA session, double-click My Computer on the remote desktop. The My
Computer screen appears:
An example of the mapped client drives available when you connect to a Windows
server
When co
nnected
to publis
hed appli
cations,
users can
access
local
drives in
the same
way as
they
would
when
running a
pplicatio
ns
locally.
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To manually map a client drive on a Windows server
Mapped drives that do not appear after logon can be manually mapped from within an ICA
session. Use the following procedure to manually map a client drive:
1. In the Connection view, select the connection you want to open.
2. On the Connections menu, click Connect and log on to the server.
3. On the server, start Windows Explorer.
4. On the Tools menu, click Map Network Drive. The Map Network Drive dialog box
appears.
5. In the Drive list, select a server drive letter. This drive letter represents the mapped
client drive. Click Browse.
6. In the Browse For Folder dialog box, expand Client Network.
7. Expand Client, and select the appropriate entry for your directory from the list of
available client drives.
8. If you want to have this drive available to you each time you log on to this server,
select Reconnect at logon. Click OK.

To configure drive mapping for floppy disks
You can manually map floppy drives on servers for access within an ICA session. To do this,
access DOS formatted floppies mounted on your client device using the following command:
mount -t vfat /dev/fd0 /mnt/floppy
Then select the /mnt/floppy directory in the Drive Mapping dialog box.
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Mapping Client Printers
Client printer mapping lets users access spooled printers available to the client device from
within ICA sessions. When a server is configured to allow client printer mapping,
applications running remotely on the server can print to a spooled printer.
Servers running Citrix MetaFrame XP, Feature Release 3 or more recent versions of XenApp
provide a simplified printing setup using the universal printer driver. If the client supports
the universal printer driver and is connected to such a server and you can print PostScript
output locally, no printer configuration is required.
If you are not connected to a server running Citrix MetaFrame XP, Feature Release 3 or a
more recent version of XenApp, you can set a default printer to be available automatically
when an ICA session is started; this printer is removed when the session is terminated. This
is known as an autocreated printer. Published applications often rely on autocreated
printers to provide access to a printer because print management utilities may not be
available from the application itself.
This section describes how to set an autocreated printer. The printer used by the system is
the default printer set in the configuration file, although the Citrix Receiver for Linux also
allows the autocreation of non-default printers. To ensure that the default printer is
available as an autocreated printer, you must specify a Microsoft Windows printer driver for
it. If no default printer is set, then environment variables are searched for default printers;
otherwise, the default for the client device print setup is used. The system default printer
can be overridden by the PRINTER environment variable in Linux.
Note: When connecting to servers running Citrix XenApp for UNIX, you do not need to
specify a Microsoft Windows printer driver. For more information see the XenApp for UNIX
documentation.
This section also describes how to limit the number of printers available to the client. This
is useful where many printers are available and avoids delays when listing available
printers.

To set an autocreated printer
After you define an appropriate printer driver name (as specified by this procedure), the
printer configured on the client for autocreation has Auto Created Client printer displayed
in its associated comment field on the server.
1. Open a configuration file by doing one of the following:
•

Open wfclient.ini, in the $HOME/.ICAClient directory to apply the autocreated
printer for a single user.

Open module.ini, in the $ICAROOT/config directory to apply the autocreated
printer to all users
2. In the [WFClient] section of the file, edit the following lines:
•
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DefaultPrinter=printername (optional)
DefaultPrinterDriver=printerdrivername
where printername is the name of the chosen printer and printerdrivername is the
name of the Microsoft Windows driver for the printer.
3. Save and close the file.
Note: An autocreated printer configuration can be preserved at session termination
by changing its comment field in the print management utility before ending the
session.

To autocreate non-default printers for the Citrix
Receiver for Linux
1. In /etc/printcap, locate the printers that you want to set as the autocreated printers.
2. Add the following option:
:wd=drivername\
where drivername is the name of the driver for the autocreated printer.
Important: The Common UNIX Printing System (CUPS) recreates /etc/printcap at
startup. To avoid recreating /etc/printcap at startup, disable this behavior in the
CUPS configuration file.

To limit the list of printers configured on the client
and mapped for use from an ICA session
1. Open the configuration file, wfclient.ini, in one of the following:
•

$HOME/.ICAClient directory to limit the printers for a single user

$ICAROOT/config directory to limit the printers for all users of the client—all users
in this case being those who first use the wfcmgr program after the change
2. In the [WFClient] section of the file type:
•

ClientPrinterList=printer1:printer2:printer3
where printer1, printer2 and so on are the names of the chosen printers. Separate
printer name entries by a colon (:).
Note: New entries in wfclient.ini must also be added to the All_Regions.ini
configuration file. See Customizing the Client Using Configuration Files for more
information.
3. Save and close the file.
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Mapping Client Printers on XenApp for
Windows
This section describes how to map client printers on XenApp for Windows. You might need
to do this if, for example, the client device’s printing software does not support the
universal printer driver.
To map a local printer on a server
1. From the client, start a server connection and log on to a computer running XenApp.
2. On the Start menu, click Settings > Printers.
3. On the File menu, click Add Printer. The Add Printer wizard appears.
4. Use the wizard to add a network printer from the Client Network, Client domain with a
name similar to printer (from workstation) in session x.
Note: When connecting to servers running Presentation Server 3.0 or earlier, or when
the server has the Legacy client printers policy rule enabled, the printer name is
similar to workstation#printer.
For more information about adding printers, see your Windows operating system
documentation.
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Mapping Client Printers on XenApp for
UNIX
In a UNIX environment, printer drivers defined by the client are ignored. The printing
system on the client device must be able to handle the print format generated by the
application.
Before users can print to a client printer from Citrix XenApp for UNIX, printing must be
enabled by the administrator. For more information, see the XenApp for UNIX
documentation.
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Mapping Client Audio
Client audio mapping enables applications running on the server to play sounds through a
sound device installed on the client.
On the server, an administrator can set the audio quality and enable or disable client audio
mapping. For more information, see the XenApp documentation. A user can set the audio
quality and enable or disable client audio mapping for an entry from the client device. If
the client and server audio quality settings are different, the lower setting is used.
New audio codecs are used for connections to servers running the latest versions of
XenDesktop and XenApp. Connections to servers running older versions still use the same
codecs as before. The new codecs provide enhanced high definition, speech optimized and
low bandwidth audio, whilst reducing bandwidth requirements in most cases. As a result,
the client audio quality settings now have different meanings, depending on which version
of XenDesktop or XenApp is running on the server as described below.
The client audio quality options for connections to servers running XenDesktop 4.0 and
above:
•

High - high definition audio. This is the default setting for connections to XenDesktop
4.0 servers. It is recommended where sound quality is important, since it enables
clients to play sound files at native data rates. It requires an additional incoming ICA
connection bandwidth of approximately 80Kbps while sound is being played, making it
suitable for use over a Local Area Network (LAN), or a fast internet connection.

•

Medium - optimized for speech. This setting is optimized and recommended for
speech. It requires an additional incoming ICA bandwidth of approximately 35Kbps
while sound is being played.

•

Low - for low speed connections. This setting is recommended for low-bandwidth
connections, including most modem connections. It requires an additional incoming ICA
bandwidth of approximately 21Kbps while sound is being played.

The client audio quality options for connections to servers running versions of XenDesktop
prior to version 4.0 and all versions of XenApp:
•

High. This setting is recommended only for connections where bandwidth is plentiful
and sound quality is important. This setting enables clients to play a sound file at its
native data rate. Sounds at the highest quality level require about 1.3Mbps of
bandwidth to play clearly. Transmitting this amount of data can result in increased CPU
utilization and network congestion.

•

Medium. This setting is recommended for most LAN-based connections. This setting
causes any sounds sent to the client to be compressed to a maximum of 64Kbps. This
compression results in a moderate decrease in the quality of the sound played on the
client device. The host CPU utilization decreases compared with the uncompressed
version due to the reduction in the amount of data being sent across the wire.
Note: The Medium quality setting is not optimized for speech when the client is
connected to a server running versions of XenDesktop prior to version 4.0 and all
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Mapping Client Audio
versions of XenApp.
•

Low. This setting is recommended for low-bandwidth connections, including most
modem connections. This setting causes any sounds sent to the client to be compressed
to a maximum of 16Kbps. This compression results in a significant decrease in the
quality of the sound. The CPU requirements and benefits of this setting are similar to
those of the Medium setting; however, the lower data rate enables reasonable
performance for a low-bandwidth connection.

To configure audio mapping for a connection entry
Note: Client audio mapping is not supported when connecting to computers running Citrix
XenApp for UNIX.
1. In the Connection view, select the name of the connection for which you want to map
audio.
2. On the Connections menu, click Properties.
3. Choose Connection from the drop-down menu.
4. Select the Enable Sound check box.
5. Select High, Medium, or Low quality depending on the available bandwidth.
To set a non-default audio device
The default audio device is specified as the /dev/dsp file for Linux. Use the following
procedure to specify a different device:
1. Choose and open a configuration file according to which users you want your changes to
affect. See Customizing the Client Using Configuration Files for information about how
updates to particular configuration files affect different users.
2. Add the following option, creating the section if necessary:
[ClientAudio]
AudioDevice = /dev/dspN
where dspN is the entry in /dev that defines the audio device to the operating system.
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Configuring Citrix XenApp
This section describes how to configure Citrix XenApp. Citrix XenApp enables users to
connect to published resources (that is, published applications, desktops, and published
content) through a server running a XenApp Services site. Citrix XenApp also creates the
menu and desktop items through which users access published resources. Although you can
view published applications and published content, you cannot view connection entries
from the Citrix XenApp view.
Customizable options for all users running Citrix XenApp on your network are defined in a
configuration file, config.xml, which is stored on the server running the Web Interface.
When a user starts Citrix XenApp, it reads the configuration data from the server.
Thereafter, Citrix XenApp updates its settings and user interface periodically, at intervals
specified in the config.xml file. This arrangement enables the server administrator to easily
control the options that users see, and gives users the flexibility to adjust their own
desktops, if allowed.
Important: config.xml affects all of the connections defined by the server running the
Web Interface.
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Publishing Content
Typically, the client connects to applications and desktop sessions. Another use of the
client is to open specific files associated with an application. In this case, the administrator
publishes a file, rather than an application. This process is referred to as publishing
content, and is a useful way to share any type of electronic information with network users.
Note: Published applications and published content (but not connection entries) are
together referred to as published resources.
Users connect to published content and published applications from the Citrix XenApp
view.
There is a limitation to the type of files that are recognized by the clients. For the system
to recognize the file type of the published content and for users to view it through a client,
a published application must be associated with the file type of the published file. For
example, to view a published Adobe PDF file using a client, an application such as Adobe
PDF Viewer must be published. Unless a suitable application is published, users cannot view
the published content.
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Customizing Users' Citrix XenApp Options
Use the Web Interface to simplify the customization of users’ Citrix XenApp options through
config.xml. For more information, see the Web Interface documentation.
Any changes to config.xml are made available to the clients only after one of the following
events takes place:
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•

A user restarts Citrix XenApp locally.

•

A user clicks the Refresh Settings button in the Citrix XenApp dialog box.

•

Configuration refresh takes place automatically, as specified by the server running the
Web Interface.

Limiting the Degree of Desktop
Customization Available to Users
Depending on the settings that you specify on the server running the Web Interface, you
can enable users to customize, from the client, the occurrence and location of menu items
and shortcuts for published resources. You can also control which pages of the Citrix
XenApp dialog box are visible to users, and which are hidden. For information about
configuring the options available from the drop-down list in the CitrixXenApp dialog box,
see the Web Interface documentation.
These pages enable users to perform the following tasks:
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•

The Server page enables users to select the server that is used for connections to
published resources, and to specify the logon methods to published resources.

•

The Application Display page enables users to determine how published resources are
added to their desktops and menus.

•

The Application Refresh page enables users to set how often the list of published
resources is updated on the client.

•

The Application Reconnection page enables users to specify how they disconnect from,
reconnect to, or log off from applications running on the server. This is known as
workspace control.

•

The Session Options page enables users to specify the window size, color depth, audio
quality settings, and how keyboard shortcuts are handled for sessions.

Specifying the Server Running the Web
Interface
Because Citrix XenApp uses the Web Interface as the access mechanism to published
resources, you must set up Citrix XenApp to point to the server running the Web Interface.
You can enable users to change the server location from their client if, for example, they
need to access resources through more than one server running the Web Interface.
Alternatively, you can use the Web Interface to fix the location so that users cannot modify
it. Use this option if, for example, you do not want users to access resources through other
servers running the Web Interface.
To change the location of the server on the client
Note: Before users can change the server location, the administrator must ensure that
the Server page in the Citrix XenApp dialog box is visible, and that the appropriate
settings are enabled on the server running the Web Interface. For more information about
these settings, see the Web Interface documentation.
1. On the Tools menu of the main client window, click Settings.
2. From the drop-down list, choose Citrix XenApp to display the Citrix XenApp page.
3. From the drop-down list, choose Server to display the Server page.
4. On the Server page, click Change.
5. In the Citrix XenApp Configuration dialog box, enter the URL of the configuration file
on the server that you want to use, or select a previously entered URL from the
drop-down list. You can enter just the server name, not the fully qualified URL, in the
Citrix XenApp Configuration dialog box. The client reads the configuration file from
the default location on that server.
6. Click Update.
7. On the Citrix XenApp page, click OK.
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Specifying a Logon Method
You can use the Web Interface to define the logon methods that are available to users when
they access published resources. By default, Citrix XenApp prompts users to provide their
credentials and then reuses them each time they connect to a resource, but you can also
enable anonymous logons or password saving.
Depending on the logon choices that you enable, users can select a logon method for the
resources that they access through Citrix XenApp. Although a variety of methods can be
selected, only Anonymous logon, Prompt user, and Pass-through authentication (using
Kerberos) are supported by the client.
Note: Only supported logon methods are displayed in the Logon mode drop-down list
offered to the user in the client’s Citrix XenApp dialog box.
To select a logon method for accessing published resources on the client
Important: Before users can choose logon methods, the administrator must decide what
logon methods are appropriate and specify these using the Web Interface. The
administrator must also ensure that the Server page in the Citrix XenApp dialog box is
visible, and that the appropriate settings are enabled on the server running the Web
Interface. For more information about these settings, see the Web Interface
documentation.
1. On the Tools menu of the Connection view, click Settings.
2. From the drop-down list, choose Citrix XenApp to display the Citrix XenApp page.
3. From the drop-down list, choose Server to display the Server page.
4. Under Logon mode on the Server page, select the logon method you want to use for all
of your connections. Only those supported logon methods that are specified in
config.xml appear.
5. Click OK.

96

Customizing Desktop Access to
Published Resources
If the server running the Web Interface is set up to allow it, users can adapt KDE or GNOME
desktop access to their published resources. With full control over customization, users can:

•

Choose to have available resources displayed in a menu

•

Create desktop shortcuts to the resources

•

Specify how their client refreshes the list of resources

Administrators can limit the degree to which users can customize these features by using
the Web Interface to disable one or more of the five pages of the Citrix XenApp dialog box
in the client.
To customize the KDE or GNOME desktop on the client
1. On the Tools menu, click Settings.
2. From the drop-down list, choose Citrix XenApp to display the Citrix XenApp page.
Depending on the content of config.xml, one or more of the five options in the
drop-down list on this page—Server, Application Display, Application Refresh,
Application Reconnection, and Session Options—may not be available. For information
about configuring the options available from the drop-down list, see the Web Interface
documentation.
3. To display published resources on the KDE or GNOME menu system, on the Application
Display page, select Show applications in menu. Your local desktop system controls in
which menu the resources appear.
4. To display published resources on the desktop, on the Application Display page, select
Show applications in desktop folder. By default, no name is provided and each
resource appears as an individual desktop shortcut. You can put resources in a desktop
folder by entering a name in the box.
5. If the Application Refresh page is available, you can also define how the client updates
the display of any menus, desktop items, and published resources in the Citrix XenApp
view. Click one or more options on the Application Refresh page:
•

Refresh list at start. The display updates when you restart the client.

•

Refresh list when remote application launches. The display updates when a new
connection is launched to a published application.

Refresh list on hourly interval. The display updates at intervals specified by the
number of hours in the box.
6. Click OK.
•
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Customizing Desktop Access to Published Resources
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Configuring Workspace Control
Workspace control provides users with the ability to quickly disconnect from all running
applications, reconnect to applications, or log off from all running applications. You can
move among user devices and gain access to all of your applications when you log on.
Important: Workspace control is available only to users connecting to published resources
with Citrix XenApp or through the Web Interface.
User policies and client drive mappings change appropriately when you move to a new user
device. Policies and mappings are applied according to the user device where you are
currently logged on to the session.
Administrators can configure the workspace control settings available to users using the
Web Interface. If the workspace control settings are configured to enable users to override
the server settings, users can configure workspace control using the Application
Reconnection page in the Citrix XenApp dialog box.
If users log on with smart cards, then a trust relationship must be set up between the server
running the Web Interface and any other server in the farm that the Web Interface accesses
for published applications.
For more information about workspace control requirements and server configuration, see
the XenApp and Web Interface documentation.
Note: Workspace control is not available for resources published on servers running Citrix
XenApp for UNIX.
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To configure workspace control settings
on the client
Before users can change the workspace control settings, the administrator must ensure that
the Application Reconnection page in the Citrix XenApp dialog box is visible, and that the
appropriate settings are enabled on the server running the Web Interface. For more
information about these settings, see the Web Interfacedocumentation.
1. On the Tools menu of the main client window, click Settings.
2. From the drop-down list, choose Citrix XenApp to display the Citrix XenApp page.
3. From the drop-down list, choose Application Reconnection to display the Application
Reconnection page.
4. Configure the workspace control settings you want to use for all of your connections.
The following options are available:
•

Enable automatic reconnection at logon enables you to reconnect to disconnected
applications, or to both disconnected applications and active applications running
on another client device, when you log on

•

Enable automatic reconnection from Reconnect menu enables you to reconnect
to disconnected applications, or to both disconnected applications and active
applications running on another client device, by clicking Reconnect Citrix XenApp
on the Citrix XenApp menu from the Citrix XenApp view

Customize Logoff Button enables you to configure whether the log off command
will include logging you off from applications that are running in the session
5. Click OK.
•
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Configuring Session Options
Using the Session Options page, you can define the window size, color depth, and sound
quality of ICA sessions.
The preferences users set for color depth and sound quality affect the amount of bandwidth
the ICA session consumes. To limit bandwidth consumption, you can prevent users from
overriding the server settings for some or all of the options on this page. When you prevent
users from overriding the server settings, the settings configured on the server running the
Web Interface are applied to connections from each client.
To configure session option settings on the client
Important: Before users can change the session option settings, the administrator must
ensure that the Session Options page in the Citrix XenApp dialog box is visible, and that
the appropriate settings are enabled on the server running the Web Interface. For more
information about these settings, see the Web Interface documentation.
1. On the Tools menu of the main client window, click Settings.
2. From the drop-down list, choose Citrix XenApp, to display the Citrix XenApp page.
3. From the drop-down list, choose Session Options, to display the Session Options page.
4. Configure the session options settings you want to use for all of your connections. You
can:
•

Change the Window Size

•

Adjust the Colors

•

Adjust the level of Audio

•
Configure the Handling of keyboard shortcuts
5. Click OK.
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Supporting NDS Users
Users can choose to use their Novell Directory Services credentials to access a published
resource using Citrix XenApp, if the server to which they are connecting supports NDS.
Important: Browsing the NDS tree requires that the Novell library, /usr/lib/libldapsdk.so,
is installed on the client machine. This is provided by the NLDAPsdk package, part of the
eDirectory product, and is available from Novell’s download page at www.novell.com.
To use NDS if the tree name is not in DNS
Novell suggests entering the configured NDS tree name into the Domain Name Server (DNS)
to enable the client to look up the IP address for the NDS server. If the NDS tree name is
not entered into DNS, use the following procedure to specify the name or IP address of the
NDS server.
1. Do one of the following:
•

Open the configuration file, wfclient.ini, in the $HOME/.ICAClient directory to
enable a specific user to access the NDS server

Open the configuration file, wfclient.ini, in the $ICAROOT/config directory to
enable all users to access the NDS server—all users in this case being those who use
the wfcmgr program after the change
2. In the [WFClient] section of the file, add the following line: NDSTree=server1:ppp
server2:ppp server3:ppp
•

where :ppp is an optional port number and server1, server2, and so on are either names
of NDS servers, or IP addresses of NDS servers. You can use a mixture of server names
and IP addresses, with a space separating the entries.
Note: New entries in wfclient.ini must also be added to the All_Regions.ini
configuration file. See Customizing the Client Using Configuration Files for more
information.
3. Save and close the file.
Note: The client always tries to access the tree name sent by the server running the
Web Interface before checking the configuration file for server details.
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Configuring USB Support
USB support enables users to interact with a wide range of USB devices when connected to
a virtual desktop. Users can plug a USB device into their client workstation and that device
is remoted to their virtual desktop. Devices available for remoting include webcams, flash
drives, smartphones, PDAs, printers, scanners, MP3 players, security devices, and tablets.
By default, certain types of device cannot be remoted. For example, a user may have a
network interface card attached to the system board by internal USB. Remoting this would
not be desirable. The following types of USB devices are not available by default for
remoting:
•

Keyboards

•

Mice

•

Bluetooth dongles

•

Smart cards

•

Integrated network interface cards

•

USB hubs

To update the default list of USB devices available for remoting, you must edit the usb.conf
file, located in $ICAROOT/. For more information, see Updating the List of USB Devices
Available for Remoting.
You must also enable the USB policy rule, which is located in the USB subfolder of the
Client Devices Resources folder in the Presentation Server Console. For more information,
see the XenDesktop documentation.
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How USB Support Works
When a user plugs in a USB device, it is checked against the USB policy, and, if allowed,
remoted to the virtual desktop. If the device is denied by the default policy, it is available
only to the local desktop.
For full-screen-only desktops, when a user plugs in a USB device, that device is
automatically remoted to the virtual desktop. The virtual desktop is responsible for
controlling the USB device and displaying it in the user interface.
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Mass Storage Devices
If a user disconnects from a virtual desktop when a mass storage device is still plugged in to
the local desktop, that device is not remoted to the virtual desktop when the user
reconnects. To ensure the mass storage device is remoted to the virtual desktop, the user
must remove and re-insert the device after reconnecting.
Note: If you insert a mass storage device into a Linux workstation that has been
configured to deny remote support for USB mass storage devices, the device will not be
accepted by the Citrix Receiver for Linux software and a Linux file browser may open on
top of the full-screen XenDesktop window. Therefore, Citrix recommends that you
pre-configure user devices with the Browse removable media when inserted setting
cleared by default. On Debian-based devices, do this using the Debian menu bar by
selecting Desktop > Preferences > Removable Drives and Media, and on the Storage
tab, under Removable Storage, clear the Browse removable media when inserted
check box.
Note: Mass storage devices can often be accessed through client drive mapping, and so
USB support is not required.
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Default Settings for USB Device Classes
The default USB policy rules allow or deny USB devices by class. Certain classes of devices
are denied by default for security or other reasons.
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USB Classes Allowed by Default
The following classes of USB device are allowed by the default USB policy rules:
Audio (Class 01)
Includes audio input devices (microphones), audio output devices, and MIDI controllers.
Physical Interface (Class 05)
These devices are similar to HIDs, but generally provide real-time input or feedback and
include force feedback joysticks, motion platforms, and force feedback exoskeletons.
Still Imaging (Class 06)
Includes digital cameras and scanners. Digital cameras often support the still imaging class
which uses the Picture Transfer Protocol (PTP) or Media Transfer Protocol (MTP) to transfer
images to a computer or other peripheral.
Cameras may also appear as mass storage devices and it may be possible to configure a
camera to use either class, through setup menus provided by the camera itself.
Printers (Class 07)
In general most printers are included in this class, although some use vendor-specific
protocols (class ff). Multifunction printers may have an internal hub or be composite
devices. In both cases the printing element generally uses the Printers class and the
scanning or fax element uses another class; for example, Still Imaging.
Mass Storage (Class 08)
The most common mass storage devices are USB flash drives; others include USB-attached
hard drives, CD/DVD drives, and SD/MMC card readers. There are a wide variety of devices
having internal storage which also present a mass storage interface; these include media
players, digital cameras, and mobile phones. Known subclasses include:
•

01 Limited flash devices

•

02 Typically CD/DVD devices (ATAPI/MMC-2)

•

03 Typically tape devices (QIC-157)

•

04 Typically floppy disk drives (UFI)

•

05 Typically floppy disk drives (SFF-8070i)

•

06 Most mass storage devices use this variant of SCSI

Mass storage devices can often be accessed through client drive mapping, and so USB
support is not required.
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USB Classes Allowed by Default
Important: Some viruses are known to propagate actively using all types of mass storage.
Consider carefully whether or not there is a business need to permit the use of mass
storage devices, either through client drive mapping, or USB support.
Content Security (Class 0d)
Content security devices enforce content protection, typically for licensing or digital rights
management. This class includes dongles.
Video (Class 0e)
The video class covers devices that are used to manipulate video or video-related material,
such as webcams, digital camcorders, analog video converters, some television tuners, and
some digital cameras that support video streaming.
Personal Healthcare (Class 0f)
These devices include personal healthcare devices such as blood pressure sensors, heart
rate monitors, pedometers, pill monitors, and spirometers.
Application and Vendor Specific (Classes fe and ff)
Many devices use vendor specific protocols or protocols not standardized by the USB
consortium, and these usually appear as vendor-specific (class ff).

108

USB Device Classes Denied by Default
The following classes of USB device are denied by the default USB policy rules:
Communications and CDC Control (Classes 02 and 0a)
Includes modems, ISDN adapters, network adapters, and some telephones and fax
machines.
The default USB policy does not allow these devices, because one of them may be providing
the connection to the virtual desktop itself.
Human Interface Devices (Class 03)
Includes a wide variety of both input and output devices. Typical Human Interface Devices
(HIDs) are keyboards, mice, pointing devices, graphic tablets, sensors, game controllers,
buttons, and control functions.
Subclass 01 is known as the boot interface class and is used for keyboards and mice.
The default USB policy does not allow USB keyboards (class 03, subclass 01, protocol 1), or
USB mice (class 03, subclass 01, protocol 2). This is because most keyboards and mice are
handled appropriately without USB support and it is normally necessary to use these devices
locally as well remotely when connecting to a virtual desktop.
USB Hubs (Class 09)
USB Hubs allow extra devices to be connected to the local computer. It is not necessary to
access these devices remotely.
Smart card (Class 0b)
Smart card readers include contactless and contact smart card readers, and also USB tokens
with an embedded smart card equivalent chip.
Smart card readers are accessed using Smart card Remoting and do not require USB support.
Wireless Controllers (Class e0)
Includes a wide variety of wireless controllers, such as ultra wide band controllers and
Bluetooth.
Some of these devices may be providing critical network access, or connecting critical
peripherals like Bluetooth keyboards or mice.
The default USB policy does not allow these devices. However, there may be particular
devices it is appropriate to provide access to using USB support. You can do this by setting
up your own USB policy rules.
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Updating the List of USB Devices
Available for Remoting
You can update the range of USB devices available for remoting to desktops by editing the
list of default rules contained in the usb.conf file located on the user device in $ICAROOT/.
You update the list by adding new policy rules to allow or deny USB devices not included in
the default range. Rules created by an administrator in this way are applied before the
default rules when a virtual desktop starts. This allows you to override the default rules
provided by XenDesktop.
The default policy configuration for disallowed devices is:
DENY: class=09 # Hub devices
DENY: class=03 subclass=01 # HID Boot device (keyboards and mice)
DENY: class=0b # Smartcard
DENY: class=e0 # Wireless Controllers
DENY: class=02 # Communications and CDC Control
DENY: class=0a # CDC Data
ALLOW: # Ultimate fallback: allow everything else
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Creating USB Policy Rules
Tip: When creating new policy rules, refer to the USB Class Codes, available from the USB
Web site at http://www.usb.org/
Policy rules in usb.conf on the client take the format {ALLOW:|DENY:} followed by a set of
expressions based on values for the following tags:

Tag

Description

VID

Vendor ID from the device descriptor

REL

Release ID from the device descriptor

PID

Product ID from the device descriptor

Class

Class from either the device descriptor or
an interface descriptor

SubClass

SubClass from either the device descriptor
or an interface descriptor

Prot

Protocol from either the device descriptor
or an interface descriptor
When creating new policy rules, be aware of the following:
•

Rules are case-insensitive.

•

Rules may have an optional comment at the end, introduced by "#". A delimiter is not
required and the comment is ignored for matching purposes.

•

Blank and pure comment lines are ignored.

•

Whitespace used as a separator is ignored, but cannot appear in the middle of a number
or identifier. For example, Deny: Class=08 SubClass=05 is a valid rule; Deny: Class=0 8
Sub Class=05 is not.

•

Tags must use the matching operator "=". For example, VID=1230.

Example
The following example shows a section of the usb.conf file on the client. For these rules to
be implemented, the same set of rules must exist on the server.
ALLOW: VID=1230 PID=0007 # ANOther Industries, ANOther Flash Drive
DENY: Class=08 SubClass=05 # Mass Storage Devices
DENY: Class=0D # All Security Devices
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Configuring Start-Up Modes
You can change how a virtual desktop handles previously attached USB devices using the
DesktopApplianceMode setting in the WfClient section in the file
$ICAROOT/config/module.ini on each client, as follows.
[WfClient]
DesktopApplianceMode = Boolean
where Boolean can have one of the following values:
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TRUE

Any USB devices that are already plugged
in start up provided the device is not
disallowed with a Deny rule in the USB
policies on either the server (registry
entry) or the client (policy rules
configuration file).

FALSE

No USB devices start up.

Securing Client Communication
You can integrate the client with a range of security technologies, including proxy servers,
firewalls, and SSL/TLS-based systems. This section discusses the measures you can take to
secure communication between your server farm and the client.
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Connecting Through a Proxy Server
Proxy servers are used to limit access to and from your network, and to handle connections
between clients and the servers. The client supports the SOCKS protocol, along with the
Secure Gateway and Citrix SSL Relay, the secure proxy protocol, and Windows NT
Challenge/Response (NTLM) authentication.
Note: To ensure a secure connection, enable TLS/SSL.
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Using Auto-Client Proxy Detection
If you are deploying clients in an organization with many proxy servers, consider using
auto-client proxy detection. Auto-client proxy detection communicates with the local Web
browser to discover the details of the proxy server. It is also useful if you cannot determine
which proxy server will be used when you configure the client.
Auto-client proxy detection can be used with Firefox, Mozilla, and Netscape 4.0 or later.
To configure auto-client proxy detection by default
On the Tools menu, click Settings.
2. From the drop-down list, choose Firewall to display the Firewall page.
3. Select Use Browser settings.
4. Click OK.
To configure auto-client proxy detection for a server connection
1. In the Connection view, select the connection for which you want to specify auto-client
proxy detection.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Firewall to display the Firewall page.
Select Use Browser settings.
Important: If the list appears dimmed, clear the Use default check box to stop using
the default protocol, and then select Use Browser settings.
5. Click OK.
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Connecting Through a SOCKS Proxy
Server
To specify a default SOCKS proxy manually
1. On the Tools menu, click Settings.
2. From the drop-down list, choose Firewall to display the Firewall page.
3. Select SOCKS.
4. Type the proxy name or IP address in the Proxy Address box and the port number in
the Port box for the SOCKS proxy server.
5. Enter the user name and password to use when connecting to the proxy server in the
Username and Password boxes if required.
6. Click OK.

To specify a SOCKS proxy for a server connection
manually
1. In the Connection view, select the connection for which you want to specify a SOCKS
proxy server.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Firewall to display the Firewall page.
4. Select SOCKS.
Important: If the list appears dimmed, clear the Use default check box to stop using
the default protocol, and then select SOCKS.
5. Type the proxy name or IP address in the Proxy Address box and the port number in
the Port box for the SOCKS proxy server.
6. Enter the user name and password to use when connecting to the proxy server in the
Username and Password boxes if required.
7. Click OK.

116

Connecting Through a Secure Proxy
Server
Configuring connections to use the secure proxy protocol also enables support for Windows
NT Challenge/Response (NTLM) authentication. If this protocol is available, it is detected
and used at run time without any additional configuration.
Important: NTLM support requires that the OpenSSL library, libcrypto.so, is installed on
the client device. This library is often included in Linux distributions, but can be
downloaded from http://www.openssl.org/ if required.

To specify a default secure proxy server manually
1. On the Tools menu, click Settings.
2. From the drop-down list, choose Firewall to display the Firewall page.
3. Select Secure (HTTPS).
4. Type the proxy name or IP address in the Proxy Address box and the port number in
the Port box for the secure proxy server.
5. Enter the user name and password to use when connecting to the proxy server in the
Username and Password boxes if required.
6. Click OK.
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To specify a secure proxy server for a server
connection manually
1. In the Connection view, select the connection for which you want to specify a secure
proxy server.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Firewall to display the Firewall page.
4. Select Secure (HTTPS).
Important: If the list appears dimmed, clear the Use default check box to stop using
the default protocol, and then select Secure (HTTPS).
5. Type the proxy name or IP address in the Proxy Address box and the port number in
the Port box for the secure proxy server.
6. Enter the user name and password to use when connecting to the proxy server in the
Username and Password boxes if required.
7. Click OK.
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Configuring Automatic Proxy Detection
This setting detects a proxy server automatically by querying http://wpad/wpad.dat/ for
proxy information. This feature means administrators do not have to spend time supporting
incorrect or dynamic configurations; however, the administrator must set up the correct
proxy information on http://wpad/wpad.dat/ to enable the client to collect it successfully.

To configure automatic proxy detection by default
1. On the Tools menu, click Settings.
2. From the drop-down list, choose Firewall to display the Firewall page.
3. Select Automatically detect proxy.
4. Click OK.

To configure automatic proxy detection for a server
connection
1. In the Connection view, select the connection for which you want to specify automatic
proxy detection.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Firewall to display the Firewall page.
4. Select Automatically detect proxy.
Important: If the list appears dimmed, clear the Use Default check box to stop using
the default protocol, and then select Automatically detect proxy.
5. Click OK.
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Using the Secure Gateway or Citrix SSL
Relay
You can integrate the Citrix Receiver for Linux with:
•

Citrix SSL Relay

•

The Secure Gateway

•

SSL provides strong encryption to increase the privacy of your server connections and
certificate-based server authentication to ensure that the server you are connecting to
is genuine.

•

TLS (Transport Layer Security) is the latest, standardized version of the SSL protocol.
The Internet Engineering Taskforce (IETF) renamed it TLS when they took over
responsibility for the development of SSL as an open standard. TLS secures data
communications by providing server authentication, encryption of the data stream, and
message integrity checks. Because there are only minor technical differences between
SSL Version 3.0 and TLS Version 1.0, the certificates you use for SSL in your installation
will also work with TLS . Some organizations, including US government organizations,
require the use of TLS to secure data communications.

You can use the Secure Gateway in either Normal mode or Relay mode to provide a secure
channel for communication between the client and the server. No client configuration is
required if you are using the Secure Gateway in Normal mode and users are connecting
through the Web Interface. If you are using Relay mode, the Secure Gateway server
functions as a proxy and you must configure the client to specify the Secure Gateway relay
server as described below.
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To specify a default Secure Gateway
server
1. On the Tools menu, click Settings.
2. From the drop-down list, choose Secure Gateway to display the Secure Gateway page.
Note: The Secure Gateway option appears dimmed unless the default network
protocol on the Server Location page is SSL/TLS + HTTPS server location.
3. Type the fully qualified domain name of the Secure Gateway server in the Secure
gateway address box, and the port number in the Port box.
4. Click OK.
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To specify a Secure Gateway for a server
connection
1. In the Connection view, select the connection for which you want to specify a Secure
Gateway server.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Secure Gateway to display the Secure Gateway page.
Note: The Secure Gateway option appears dimmed unless the default network
protocol on the Server Location page is SSL/TLS + HTTPS server location.
4. Type the fully qualified domain name of the Secure Gateway server in the Secure
gateway address box, and the port number in the Port box.
5. Click OK.
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Configuring and Enabling the Client for
SSL and TLS
SSL and TLS are configured in the same way and use the same certificates. When both SSL
and TLS are enabled, each time you initiate a connection the client tries to use TLS first,
and then SSL. If it cannot connect with SSL, the connection fails and an error message
appears.
To use SSL or TLS, you need a root certificate on the client device that can verify the
signature of the Certificate Authority on the server certificate. Support for the certificates
listed below is built in to Citrix SSL- and TLS-enabled clients:
Certificate

Issuing Authority

Class4PCA_G2_v2.crt

VeriSign Trust Network

Class3PCA_G2_v2.crt

VeriSign Trust Network

BTCTRoot.crt

Baltimore Cyber Trust Root

GTECTGlobalRoot.crt

GTE Cyber Trust Global Root

Pcs3ss_v4.crt

Class 3 Public Primary Certification
Authority

SecureServer.crt
Secure Server Certification Authority
You are not required to obtain and install root certificates on the client device to use the
certificates from these Certificate Authorities. However, if you choose to use a different
Certificate Authority, you must obtain and install a root certificate from the Certificate
Authority on each client device.
To install a root certificate, copy any new Certificate Authority (root) certificate files to
the subdirectory keystore/cacerts in the installation directory ($ICAROOT). To enable the
client to use the new certificate, you must restart wfcmgr after adding the certificate.
Important: The client does not support keys of more than 2048 bits. You must ensure
that the Certificate Authority root and intermediate certificates, and your server
certificates, are less than or equal to 2048 bits long.
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To configure the client to use SSL or TLS
on a single connection
1. In the Connection view, select the connection for which you want to use SSL.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Network to display the Network page.
4. Select SSL/TLS + HTTPS server location from the Network Protocol list.
Important: If the list appears dimmed, clear the Use Default check box to stop using
the default protocol, and then select SSL/TLS + HTTPS server location from the
Network Protocol list.
5. Select the server location through one of the following methods:
•

Select the Use Default check box.

Enter the fully qualified domain name of the machine to use for server browsing in
the Server Location box.
6. Click OK.
•
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To configure a default protocol as SSL or
TLS
1. On the Tools menu, click Settings.
2. From the drop-down list, choose Server Location to display the Server Location page.
3. Select SSL/TLS + HTTPS server location from the Network Protocol list.
Note: You can specify this protocol for all connections or for individual server groups
and servers using the Server Group list and Address List.
4. Click OK.
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To force TLS connections
To force clients to connect only with TLS, you must specify TLS on your Secure Gateway
server or SSL Relay.
For more information about the Secure Gateway for Windows or Citrix SSL Relay, see the
XenApp documentation.
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Connecting to a Server Through a
Firewall
Network firewalls can allow or block packets based on the destination address and port. If
you are using the client through a network firewall that maps the server’s internal network
IP address to an external Internet address, use the information provided in this topic to
configure the firewall settings.
To connect across an address-translating firewall
1. On the Tools menu, click Settings.
2. From the drop-down list, choose Firewall to display the Firewall page.
3. Select the Use alternate address for firewall connection check box.
4. Add the external Internet address of a server that is on the subnet to which you want to
connect to the Address List on the Server Location page. See Configuring ICA
Browsing.
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Using ICA Encryption
Encryption increases the security of your server connection. By default, basic encryption is
enabled on all connections. The client must be configured to use the minimum encryption
level required by the server, or greater. To enable encryption levels higher than Basic, the
server must support ICA encryption.
To change the encryption settings
1. In the Connection view, select the connection for which you want to change encryption
settings.
2. On the Connections menu, click Properties.
3. From the drop-down list, choose Connection to display the Connection page.
4. From the Encryption Level list, choose an encryption level.
5. Click OK.
Note: The server can be configured to allow connections only from clients that
support basic or advanced encryption. For more information about configuring the
server to check encryption levels before allowing connections, see the XenApp
documentation.
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Enabling Smart Card Support
The Citrix Receiver for Linux supports for a number of smart card readers. If smart card
support is enabled on both the server and client, you can use smart cards for the following
purposes:

•

Smart card logon authentication. Use smart cards to authenticate users to Citrix
XenApp servers.

•

Smart card application support. Enable smart card-aware published applications to
access local smart card devices.

For more information about configuring smart card support on your servers, see the XenApp
documentation.
Note: Smart card data is security-sensitive and should be transmitted over a secure
authenticated channel such as SSL/TLS.
Smart card support has the following prerequisites:

•

Your smart card readers and published applications must be PC/SC industry standard
compliant

•

You must install the appropriate driver for your smart card reader

•

You must install the PC/SC Lite package (including the Resource Manager daemon and
shared library), available for download from http://www.linuxnet.com/

Important: If you are using the SunRay terminal with SunRay server software Version 2.0
or above, you must install the PC/SC SRCOM bypass package, available for download from
http://www.sun.com/.
To configure smart card support
1. Do one of the following:
•

In the Connection view, click New on the Connections menu to configure a new
connection.

Select an existing connection entry you want to configure. On the Connections
menu, click Properties.
2. From the drop-down list, choose Login to display the Login page.
•

3. Click Allow Smart Card Logon.
4. Click OK.
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Troubleshooting
This section contains information to help administrators troubleshoot any issues with Citrix
Receiver for Linux.
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Known Issues
The following topics describe known issues with the Citrix Receiver for Linux in various
different categories and how to go about resolving them.
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Connection Issues
The following are known connection issues.
My seamless connections do not share sessions
Seamless connections can share sessions with other seamless connections. For sessions
started using Citrix XenApp or the Web Interface, session sharing occurs as directed by the
server. However, locally defined sessions, shown in Connection View, will not share unless
they have the same user name and domain credentials. For seamless connections, these
credentials should be specified to enable sharing to occur. To override this behavior set the
following line in wfclient.ini or module.ini - see Customizing the Client Using Configuration
Files for information about how updates to particular configuration files affect different
users:
SessionSharingLoose=True
This enables sessions without prespecified credentials to share with existing sessions.
I cannot connect properly to a published resource or desktop session
If, when establishing a connection to a Windows server, the client dialog box appears with
the message “Connecting to server…” but no subsequent connection window appears, you
may need to configure the server with a Client Access License (CAL). For more information
about licensing, see Licensing Your Product.
I have problems using network address translation with SSL/TLS through a firewall
A valid SSL/TLS relay host must be specified for SSL/TLS to work correctly when the
Firewall setting Use alternate address for firewall connection is selected.
For information about specifying an SSL/TLS relay host, see Using the Secure Gateway or
Citrix SSL Relay.
I cannot connect to the Citrix SSL Relay server
If the Citrix SSL Relay server is set to a port other than 443, the Citrix Receiver for Linux
cannot connect to a server.
For information about specifying a port for the Citrix SSL Relay, see Using the Secure
Gateway or Citrix SSL Relay .
I sometimes fail to connect when I try reconnecting to sessions
Sometimes reconnecting to a session with a higher color depth than that requested by the
client causes the connection to fail. This is due to a lack of available memory on the server.
If the reconnection fails, the client will try to use the original color depth. Otherwise, the
server will try to start a new session with the requested color depth, leaving the original
session in a disconnected state. However, the second connection may also fail if there is
still a lack of available memory on the server.
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I cannot connect to a server using its full Internet name
Citrix recommends that you configure DNS (Domain Name Server) on your network to enable
you to resolve the names of servers to which you want to connect. If you do not have DNS
configured, it may not be possible to resolve the server name to an IP address.
Alternatively, you can specify the server by its IP address, rather than by its name.
I get a “Proxy detection failure” error message when connecting
If your connection is configured to use automatic proxy detection and you see a “Proxy
detection failure: Javascript error” error message when trying to connect, copy the
wpad.dat file into $ICAROOT/util. Run the following command, where hostname is the
hostname of the server to which you are trying to connect:
cat wpad.dat | ./pacexec pac.js FindProxyForURL http://hostname
hostname 2>&1 | grep “undeclared variable”
If you get no output, there is a serious issue with the wpad.dat file on the server that you
need to investigate. However, if you see output such as “assignment to undeclared variable
...” you can fix the problem. Open pac.js and for each variable listed in the output, add a
line at the top of the file in the following format, where “...” is the variable name.
var ...;
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Display Issues
The following are known display issues.

I experience problems with over-scrolling when using
published applications
Note: These problems do not occur when connecting to servers running Citrix
Presentation Server 4.5 or later or Citrix XenApp.
To prevent over-scrolling
1. Open the configuration file, wfclient.ini, in the $HOME/.ICAClient directory.
2. In the [Thinwire 3.0] section of the file, type:
TW2StopwatchMinimum=100
Note: You must also add the new entries in wfclient.ini to the All_Regions.ini
configuration file. See Customizing the Client Using Configuration Files for more
information.
3. Save and close the file. The lowest effective value is likely to be 100, but you may need
to experiment with this value to find the optimum solution.

Incorrect keystrokes are displayed when I use the
keyboard
If you are using a non-English language keyboard, the screen display may not match the
keyboard input. In this case, you should specify the keyboard type and layout that you are
using. For more information about specifying keyboards, see Configuring Keyboard Options,
Alert Sounds, and Digital Dictation Support.

Ghosting occurs when I minimize or maximize a
window
With some applications (including Microsoft Outlook), ghost windows can appear when
maximizing or iconifying local, seamless windows (for example, when you use the ALT+F9
shortcut key combination on a connection window). The ghost windows may appear to
display the contents of another window and may be difficult to remove.
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To prevent ghosting, use the Iconify button on the server window rather than on the local
window.

I see excessive redrawing when moving seamless
windows
Some window managers continuously report the new window position when moving a
window, which can result in excessive redrawing. To fix this problem, switch the window
manager to a mode that draws window outlines only when moving a window.

Running in seamless mode using different window
managers
Seamless mode removes local window manager decorations such as the title bar and
borders, and instead uses decorations sent from the server. Different window managers use
different ways of removing window decorations.
The client sets the _MOTIF_DECORATIONS hint to remove the decorations. It also sets the
class of all seamless windows to “Wfica_Seamless”, so that a window manager that does not
recognize the Motif hint can be told to remove the decorations through resource file
entries.

Icon compatibility
The client creates window icons that work with most window managers, but are not fully
compatible with the X Inter-Client Communication Convention.
To provide full icon compatibility
1. Open the wfclient.ini configuration file.
2. Edit the following line in the [WFClient] section: UseIconWindow=True
3. Save and close the file.

I have cursor visibility problems
The cursor can be difficult to see if it is the same or similar in color to the background. You
can fix this by forcing areas of the cursor to be black or white.
To change the color of the cursor
1. Open the wfclient.ini configuration file.
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2. Add one of the following lines to the [WFClient] section:
CursorStipple=ffff,ffff (to make the cursor black)
CursorStipple=0,0 (to make the cursor white)
Note: You must add the new entries in wfclient.ini to the All_Regions.ini
configuration file. See Customizing the Client Using Configuration Files for more
information.
3. Save and close the file.

I experience color flashing on the screen
When you move the mouse into or out of an ICA connection window, the colors in the
non-focused window may start to flash. This is a known limitation when using the X
Windows System with PseudoColor displays. If possible, use a higher color depth for the
affected connection. Otherwise, use the following procedure to prevent color flashing.
To prevent color flashing with a 256-color connection
1. In the Connection view, select the connection entry that causes the flashing.
2. From the Properties page, select Window from the drop-down list to display the
Window page.
3. Select Shared - Approximate Colors and click OK.

I experience rapid color changes with TrueColor
displays
Users have the option of using 256 colors when connecting to a server. This option assumes
that the video hardware has palette support to enable applications to rapidly change the
palate colors to produce animated displays.
TrueColor displays have no facility to emulate the ability to produce animations by rapidly
changing the palette. Software emulation of this facility is expensive both in terms of time
and network traffic. To reduce this cost, the client buffers rapid palette changes, and
updates the real palette only every few seconds.

I have problems entering Polish characters on US
English keyboards
Appropriately configured Microsoft Windows servers enable users to set the input locale to
“Polish (Programmers)” to enter accented Polish characters using a US English keyboard.
This can also be configured on the Citrix Receiver for Linux.
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To allow the entry of accented Polish characters on US English keyboards
Note: This setting is not recommended for use with any other keyboard layout.
1. On the Tools menu, click Settings.
2. Select Preferences from the drop-down list to display the Preferences page.
3. Set the Keyboard Layout to Polish (Programmers) and click OK.
4. Open the wfclient.ini configuration file.
5. Edit the following line in the [WFClient] section: UnicodeKeyboard=Off
6. Save and close the file.

Japanese characters display incorrectly on my screen
The client uses EUC-JP or UTF-8 character encoding for Japanese characters, while the
server uses SJIS character encoding. The client does not translate between these character
sets. This can cause problems displaying files that are saved on the server and viewed
locally, or saved locally and viewed on the server. This issue also affects Japanese
characters in parameters used in extended parameter passing.

I can’t see any menu entries relating to the client
when using the GNOME window manager
If you install the client as a non-privileged user, the desktop integration features are not
fully enabled. To see the menu entries, install the client as a privileged user (root).

I have user interface problems when using GNOME
2.0 on SuSE 10.x
Using the xorg-x11-fonts-cyrillic font package in the GNOME desktop environment on SuSE
10.x systems can cause font loading to fail in certain applications, including the Citrix
Receiver for Linux. This can cause problems in the user interface such as missing
characters, and the following error message may appear when starting the Citrix Receiver
for Linux:
“Warning: Cannot convert string "-gnu-*-*-*-*-*-*-120-*-*-*-*-iso10646-1,-*-gothic-medium-r-n
ormal-*-*-120-*-*-*-*-ksc5601.1987-0,-*-helvetica-medium-r-*-*-*-120-75-75-*-*-iso8859-1,-*ming-*-*-*-*-*-140-*-*-*-*-big5-0,-isas-fangsong ti-medium-r-normal--16-160-72-72-c-160-gb23
12.1980-0,-*-helvetica-medium-r-normal--0-*-75-75-p-*-koi8-r,-*-helvetica-medium-r-*-*-*-12
0-75-75-*-*-iso8859-6,-*-arial-medium-r-*-*-*-120-75-75-*-*-iso8859-6,-*-helvetica-medium-r*-*-*-120-75-75-*-*-*-*,-*-*-medium-r-*-*-*-120-75-75-*-*-*-*,-*-*-medium-r-*-*-*-120-*-*-*-*-*-*"
to type FontSet”
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To avoid these problems, remove the xorg-x11-fonts-cyrillic font package from your system.
This improves the appearance of the user interface even in sessions that use Cyrillic
characters.
Alternatively, modify the client startup to run the command xset fp rehash before
launching the client or run the xset fp rehash command manually before starting the client.
Note that running the xset fp rehash command in GNOME startup programs does not always
fix this problem because the problem often does not occur until after the startup scripts
are run.

I have problems displaying Arabic characters on
Fedora Core 5
Only a limited number of fonts in Fedora Core 5 support Arabic characters, most of which
cannot be used in a UTF-8 locale. The standard Arabic desktop environment is a UTF-8
locale, and the available fonts are unsuitable for use with the client.
One workaround is to run the client in a non-UTF-8 locale. The alternative is to download
and install the GNU Unifont font; however this must be done manually because there is no
Fedora Core 5 package that includes this font.

I want to make a session that spans multiple monitors
A new command line multi-monitor display control option, -span, enables you to do this. It
allows full-screen sessions to span multiple monitors.
Important: -span has no effect on Seamless or normal windowed sessions (including those
in maximised windows).
The - span option has the following format:
-span [h][o][a|mon1[,mon2[,mon3,mon4]]]
If h is specified, then a list of monitors is printed on stdout. And if that is the whole option
value, wfica then exits.
If o is specified, then the session window will have the override-redirect redirect attribute.
Caution: The use of this option value is not recommended. It is intended as a last resort,
for use with uncooperative window managers. The session window will not be visible to
the window manager, will not have an icon and can not be restacked. It can be removed
only by ending the session.
If a is specified, then the remainder of the command line is ignored. This is used as a
dummy value to prevent the following part of the command line being incorrectly treated
as the option value.
If the option value ends here or is not present, then the client will attempt to create a
session that covers the entire display.
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Otherwise, it is assumed that the remainder of the option value is a list of monitor
numbers. A single value selects a specific monitor, two values select monitors at the
top-left and bottom-right corners of the required area, four specify monitors at the top,
bottom, left and right edges of the area.
Assuming o was not specified, wfica will use the _NET_WM_FULLSCREEN_MONITORS client
message to request an appropriate window layout from the window manager, if it is
supported. Otherwise it will use size and position hints to request the desired layout.
The following command can be used to test for window manager support:
xprop -root | grep _NET_WM_FULLSCREEN_MONITORS
If there is no output, there is no support. If there is no support, you may need an
override-redirect window. You can set up an override-redirect window using -span o.
To make a session the spans multiple monitors from the command line
1. At a command prompt, type: /usr/lib/ICAClient/wfica -span h A list of the
numbers of the monitors currently connected to the client workstation is printed to
stdout and wfica exits.
2. Make a note of these monitor numbers.
3. At a command prompt, type: /usr/lib/ICAClient/wfica -span
[w[,x[,y,z]]] where w, x, y and z are monitor numbers obtained in step 1 above
and the single value w, specifies a specific monitor, two values w and x specify
monitors at the top-left and bottom-right corners of the required area, and four values
w, x, y and z specify monitors at the top, bottom, left and right edges of the area.
Important: You must define the WFICA_OPTS variable before starting wfcmgr or
connecting to the Web interface through a browser. To do this, edit your profile file,
normally found at $HOME/.bash_profile or $HOME/.profile, adding a line to define
the WFICA_OPTS variable. For example:
export WFICA_OPTS="-span a"
Note that this change affects both XenApp and XenDesktop sessions.
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The following are known browser issues.

When I click on a link in a Windows session, the
content appears in a local browser
Server-client content redirection is enabled in wfclient.ini. This causes a local application
to run. To disable server-client content redirection, see To turn off server-client content
redirection from the client.

When accessing published resources, my browser
prompts me to save a file
Browsers other than Mozilla, Firefox, and Netscape may require configuration before you
can connect to a published resource. If you are connecting through the Web Interface, you
may be able to access the Web Interface home page with the list of resources. However,
when trying to access a resource by clicking an icon on the page, your browser prompts you
to save the ICA file.

To configure a different browser for use with the Web
Interface
Details vary among browsers, but you must either configure the browser to use the Citrix
plug-in for Netscape, npica.so, or set up the MIME data types in the browser so that the
$ICAROOT/wfica is executed as a helper application when the browser encounters data with
the application/x-ica MIME type or an .ica file.

I want to enable the ICA browser plug-in on the
Konqueror Web browser
The Konqueror browser does not automatically use the ICA browser plug-in to start ICA
sessions. To enable the plug-in, Konqueror must scan for new plug-ins. For information
about how to perform this scan, see Konqueror’s online help.
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I have problems launching published applications
using Mozilla 1.4.x
Using Mozilla 1.4.x can cause launching published applications to fail. To fix this problem,
Citrix recommends using Mozilla 1.6 or later.

I experience poor response times when viewing
certain Web sites with Microsoft Internet Explorer
If Web pages continually redraw, this can affect performance. Setting the number of screen
areas tracked to prevent redundant drawing of bitmap images can fix this problem if you
are running Version 8.x or later of the Client for Linux. Three hundred is an adequate value
for 1024 x 768 sessions.
You can set the number of screen areas tracked in the appsrv.ini configuration file or the
wfclient.ini file.

To set the number of screen areas tracked by editing appsrv
1. Open appsrv.ini.
2. Add the following lines to the section for the relevant connection:
EnableOSS=Off
TwRedundantImageItems=300
Note: You must also add the new entries in appsrv.ini to the All_Regions.ini
configuration file. See Customizing the Client Using Configuration Files.
3. Save and close the file.

To set the number of screen areas tracked by editing wfclient
1. Open wfclient.ini.
2. Add the following lines to the [WFClient] section:
EnableOSS=Off
TwRedundantImageItems=300
Note: You must also add the new entries in wfclient.ini to the All_Regions.ini
configuration file. See Customizing the Client Using Configuration Files.
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I get excessive memory use when running Microsoft
Internet Explorer
Decreasing the size of the HDX 3D Browser Acceleration cache can fix this issue.

To set the size of the HDX 3D Browser Acceleration cache
1. Open the wfclient.ini configuration file or the module.ini configuration file.
2. Add the following lines to the [WFClient] section to specify the amount of memory you
want to allocate for the cache size:
SpeedScreenBADecompressedCacheSize=x
SpeedScreenBACompressedCacheSize=y
These sizes are in kilobytes, and can be adjusted as required.
Note: You must also add the new entries in wfclient.ini to the All_Regions.ini
configuration file. See Customizing the Client Using Configuration Files for more
information.
3. Save and close the file.

I have problems using Firefox with Fedora Core 5
Fedora Core 5 ships with Firefox 1.5.0.1, however this version of Firefox does not work with
the ICA browser plug-in. To enable the plug-in and get Firefox working correctly, download
the latest version of Firefox from the Mozilla Web site at http://www.mozilla.com/firefox.

The installer does not support Mozilla Firefox or other
browsers
If you have problems using a specific Web browser such as Mozilla Firefox, set the
environment variable BROWSER to specify the local path and name of the required browser
before running setupwfc.
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The following are known issues of other sorts.
My configuration file settings no longer work after upgrading the client
For each entry in appsrv.ini and wfclient.ini, there must be a corresponding entry in
All_Regions.ini for the setting to take effect. In addition, for each entry in the
[Thinwire3.0], [ClientDrive], and [TCP/IP] sections of wfclient.ini, there must be a
corresponding entry in canonicalization.ini for the setting to take effect. See the
All_Regions.ini and canonicalization.ini files in the $ICAROOT/config directory for more
information.
My new configuration file settings are not being picked up
For each entry in appsrv.ini and wfclient.ini, there must be a corresponding entry in
All_Regions.ini for the setting to take effect. In addition, for each entry in the
[Thinwire3.0], [ClientDrive], and [TCP/IP] sections of wfclient.ini, there must be a
corresponding entry in canonicalization.ini for the setting to take effect. See the
All_Regions.ini and canonicalization.ini files in the $ICAROOT/config directory for more
information.
I get an error message when trying to run the client
If you see an error message such as “/usr/lib/ICAClient/wfcmgr: error while loading shared
libraries: libXm.so.3: cannot open shared object file: No such file or directory,” this is
because the client will not run on distributions that do not include the Motif library or those
such as Fedora Core 5 that include only the libXm.so.4 version of the Motif library. The
solution is to install libXm.so.3 Version 2.2.3.
I cannot set the attributes for files on floppy disks
Changing file attributes on a locally mounted floppy drive fails without giving a warning
message, leaving the file properties unchanged.
I have problems running published applications that access a serial port
If a published application needs to access a serial port, the application may fail (with or
without an error message, depending on the application itself) if the port has been locked
by another application. Under such circumstances, check that there are no applications
that have either temporarily locked the serial port or have locked the serial port and exited
without releasing it.
To overcome this problem, stop the application that is blocking the serial port; in the case
of UUCP-style locks, there may be a lock file left behind after after the application
exits.The location of these lock files depends on the operating system used.
I cannot start the client
If the client does not start and the error message “Application default file could not be
found or is out of date” appears, this may be because the environment variable ICAROOT is
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not defined correctly. This is a requirement if you installed the client to a non-default
location. To overcome this problem, Citrix recommends that you do one of the following:
Define ICAROOT as the installation directory.
To check the ICAROOT environment variable is defined correctly, try starting the client
from a terminal session. If the error message still appears, it is likely that the ICAROOT
environment variable is not correctly defined.
Reinstall the client to the default location. For more information about installing the
client, see Installing the Citrix Receiver for Linux.
If the client was previously installed in the default location, remove the
/usr/lib/ICAClient or $HOME/ICAClient/platform directory before reinstalling.
I have problems with file names containing accented characters on mapped drives
To ensure the correct operation of client drive mapping with file names containing
accented Western European characters, you need to set the server DOS codepage to 1252.
To do this, set the server registry entry
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Nls\CodePage\OEMCP to 1252.
However, you might then need to set the codepage back to 850 using a console window for
DOS applications to display characters correctly, and to accept alt-numeric entries from the
keypad.
For the registry setting change to take effect, you need to restart your server.
Support for Eastern European characters has been added to Version 9.x of the client. Follow
the procedure above to set the server DOS codepage to 1250.
My keyboard shortcuts do not function correctly
If your window manager uses the same keyboard shortcut combinations to provide native
functionality, your client keyboard shortcut combinations might not function correctly. For
example, the KDE window manager uses CTRL+SHIFT+F1 to CTRL+SHIFT+F4 to switch
between desktops 13 to 16. If you experience this problem, choose Direct from the
Handling of keyboard shortcuts drop-down list, or reconfigure the window manager to
suppress the default keyboard shortcut combinations. See Configuring Keyboard Shortcuts
for more information about configuring keyboard shortcuts.
I have problems using IME accelerator keys under KDE
The ATOK-IME accelerator keys on a Windows server and the KDE window manager
accelerator keys can conflict. There is an alternative keyboard file for Linux keyboards that
maps the left Windows key to be visible as the control key in an ICA session. The left
Windows key can then be used when accessing ATOK-IME functions, instead of the CTRL
key.
To select the alternative keyboard layout
1. On the Tools menu, click Settings.
2. Select Preferences from the drop-down list to display the Preferences page.
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3. Set the Keyboard Type (Client) to LINUX (Japanese KDE) and click OK.
The server does not recognize my Pocket PC
If the user logged on to the client device does not have read access to /dev/ttyUSB0, the
server cannot access a USB-tethered Pocket PC connected to the client device. The
configuration changes required to enable read access to this file vary for different UNIX
systems—see your system documentation for more information.
The server does not recognize my Pocket PC when I reconnect to a session
If you close a session in which the server accessed a USB-tethered Pocket PC, and then
reconnect, the server may not recognize the Pocket PC through the new connection. To fix
this issue, disconnect the Pocket PC from the client device and then reconnect it.
The server does not recognize a second Pocket PC connected to my client device
If you have multiple USB-tethered Pocket PCs connected to your client device, only one is
available to servers. After a server recognizes the first Pocket PC, if a second server tries to
access a second Pocket PC, a PDA contention error message appears.
I get an error message when a server connects to my Pocket PC
If the message “You do not have sufficient permission to create lockfiles in directory ...”
appears when a session accesses your USB-tethered Pocket PC, this means you cannot
create a lockfile to indicate to other programs that your Pocket PC is already in use. There
are actions you can take to prevent this message from appearing.
If you never access your Pocket PC from other programs on the client device, add the
following to the [WFClient] section of the appropriate configuration file:
ContinueWithoutPDALockFile=True
See Customizing the Client Using Configuration Files for information about how updates to
particular configuration files affect different users.
The makes the client behave as if you answered “Yes” to the message each time. Note that
the client will still detect contention with other instances of itself.
However, if you want the client to detect contention with other programs, such as SynCE,
use ls -ld on the directory given in the error message, for example, /var/lock. This probably
shows that writing is restricted to members of a group such as uucp or lock, in which case
either:
As root, set the group ownership of the client executable to match this group, for
example by typing:
chgrp uucp $ICAROOT/wfica
Set the group id when the client executes by typing:
chmod g+s $ICAROOT/wfica
This enables the client to assume the rights it needs while manipulating the lockfiles.
At other times, it will suspend those extra rights.
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Add each user who needs to connect to Pocket PCs to this group (for example, by
editing /etc/group as root). This may be particularly appropriate on machines running
Gentoo Linux.

Common Error Messages
The following list of errors is not comprehensive. The list is intended to provide
descriptions for more commonly occurring error messages.
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Connection Configuration Errors
These errors may occur if you configured a connection entry incorrectly.
E_MISSING_INI_SECTION - Error in configuration file: "..." Cannot find section "...".
The configuration file was incorrectly edited or is corrupt.
E_MISSING_INI_ENTRY - Error in configuration file. Section "..." must contain an entry
"...".
The configuration file was incorrectly edited or is corrupt.
E_INI_VENDOR_RANGE - Error in configuration file: "..." Bad Vendor Range "..."
The X Server vendor information in the configuration file is corrupt. Contact Citrix.
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wfclient.ini Configuration Errors
These errors may occur if you edited wfclient.ini incorrectly.
E_CSM_MUST_SPECIFY_SERVER - A server must be entered.
A server name must be entered on the Network page of the Properties dialog box.
E_CANNOT_WRITE_INI_FILE - Cannot write file: "..."
There was a problem saving the connection database; for example, no disk space.
E_CANNOT_CREATE_INI_FILE - Cannot create file: "..."
There was a problem creating a new connection database.
E_CSM_CONNECTLIST_INVALID - Cannot find selected connection.
The configuration file is corrupt. Create a new configuration file.
E_CSM_CONNECTION_NOTFOUND - Cannot find specified connection.
The configuration file is corrupt. Create a new configuration file.
E_CSM_APPSERVERLIST_MISSING - Error in configuration file: "..." Missing section: "..."
The configuration file is corrupt. Create a new configuration file.
E_CSM_APPSRV_SECTION_MISSING - Inconsistency in configuration file: "..." Missing
section: "..."
The configuration file is corrupt. Create a new configuration file.
E_PNAGENT_FILE_UNREADABLE - Cannot read PNAgent file "...": No such file or
directory.
— Or — Cannot read PNAgent file "...": Permission denied.
You are trying to access a resource through a desktop item or menu, but the PNAgent file
for the resource is not available. Refresh the published resources on the client by selecting
Application Refresh on the View menu, and try to access the resource again. If the error
persists, check the properties of the desktop icon or menu item, and the PNAgent file to
which the icon or item refers.
E_CSM_DESCRIPTION_NONUNIQUE - This description is already in use. The Description
must be unique.
The Description text on the Network page of the Properties dialog box must be unique.
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Drag and Drop Errors
These errors may occur when using drag and drop to open a file.
Cannot read file "...".
Check the permissions on file “...”.
File "..." is not on a drive-mapped file system.
Check the mappings on the Drive Mapping page of the Settings dialog box.
No application is associated with the type of file "...".
If you are using static file type associations, check these using the File Associations page of
the Properties dialog box for each connection that connects to a published application. If
you are using dynamic file type associations, either connect to another server that offers an
application associated with the type of file “...”, or switch to using static file type
associations and set the association up manually.
No file type associations are defined by the server you selected.
Select another server that does have file type associations defined.
The type of file "..." can not be ascertained as it does not have a file extension.
Rename file “...” to have a suitable extension.
File "..." is on a drive-mapped file system which is currently disabled.
Check the relevant drive mapping is enabled on the Drive Mapping page of the Settings
dialog box.
Client Drive Mapping is currently disabled.
Ensure the Enable Drive Mapping check box is selected on the Drive Mapping page of the
Settings dialog box.
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PAC File Errors
These errors may occur when using PAC files to specify proxy configurations.
Proxy detection failure: Improper auto-configuration URL.
An address in the browser was specified with an invalid URL type. Valid types are http://
and https://, and other types are not supported. Change the address to a valid URL type
and try again.
Proxy detection failure: .PAC script HTTP download failed: Connect failed.
Check if an incorrect name or address was entered. If so, fix the address and retry. If not,
the server could be down. Retry later.
Proxy detection failure: .PAC script HTTP download failed: Path not found.
The requested PAC file is not on the server. Either change this on the server, or reconfigure
the browser.
Proxy detection failure: .PAC script HTTP download failed.
The connection failed while downloading the PAC file. Reconnect and try again.
Proxy detection failure: Empty auto-configuration script.
The PAC file is empty. Either change this on the server, or reconfigure the browser.
Proxy detection failure: No JavaScript support.
The PAC executable or the pac.js text file is missing. Reinstall the client.
Proxy detection failure: JavaScript error.
The PAC file contains invalid JavaScript. Fix the PAC file on the server. Also see Connection
Issues.
Proxy detection failure: Improper result from proxy auto-configuration script.
A badly formed response was received from the server. Either fix this on the server, or
reconfigure the browser.
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This topic contains a list of other common error messages you may see when using the
client.
An error occurred. The error code is 11 (E_MISSING_INI_SECTION). Please refer to the
documentation. Exiting.
When running the client from the command line, this usually means the description given
on the command line was not found in the appsrv.ini file.
E_BAD_OPTION - The option "..." is not valid.
Missing argument for option “...”.
E_BAD_ARG -The option "..." has an invalid argument: "...".
Invalid argument specified for option “...”.
E_INI_KEY_SYNTAX - Error in configuration file: "..." Bad Key "..."
The X Server vendor information in the configuration file is corrupt. Create a new
configuration file.
E_INI_VALUE_SYNTAX - Error in configuration file: "..." Bad Value "..."
The X Server vendor information in the configuration file is corrupt. Create a new
configuration file.
E_SERVER_NAMELOOKUP_FAILURE - Cannot get address for server "..."
The server name cannot be resolved.
Cannot browse NDS tree: "...".
Refer to Novell documentation for further help with this error.
An error occurred writing to one or more of the files: "...".
Check for disk full issues, or permissions problems. If a problem is found and corrected,
retry the operation that prompted the error message.
Connection lost. Some data may be missing from some of the files: "...".
Reconnect and retry the operation that prompted the error.
A server application’s attempt to access a PDA device failed because it is currently in
use.
If this message appears, a server application failed to access a USB-tethered Pocket PC
because it is already being accessed either by a server application in another ICA session or
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by a local application. You can release the PDA for use by closing any other synchronization
agent that is currently running. If this does not fix the problem, contact your system
administrator.
An application on the server is requesting access to your local PDA device. This is
potentially unsafe. Do you want to grant access?
If you explicitly connect to a server or to a server application that tries to access your local
Pocket PC, either through Citrix XenApp or through the Connection View, access is
permitted automatically. However, if you are directed to a server without knowing the
server details (for example, using the Web Interface or through an ICA file), this message
appears to warn you if an application wants to access the PDA. You then have the option to
allow or deny the access.

153

Sending Diagnostic Information to Citrix
Support
If you are experiencing problems using the client, you may be asked to provide Citrix
Support with diagnostic information. This information assists Citrix Support in trying to
diagnose and offer assistance in rectifying the problem.

To obtain diagnostic information about the client
1. On the Help menu of the main client window, click Diagnostic Information. The
Diagnostic Information dialog box displays the current locations of ICAROOT and
wfcmgr.
2. Click Yes to generate a file containing detailed diagnostic information, including client
version details, the contents of the client configuration files, and the values of various
system variables. Check this file for confidential information before sending it to Citrix
Support.
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Citrix Receiver for Linux Command-Line
This section describes how to use the Citrix Receiver for Linux from the command line.
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Citrix Receiver for Linux Command-Line
Parameters
The table below lists the Citrix Receiver for Linux command-line parameters.
You can use a connection file simply by typing its name after wfica without any of the
options below.
Note: A list of the parameters can be obtained by typing wfica -?, wfica -help, or wfica -h
at a command line.
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Type

Specify the connection to use from the
Connection file.

-desc description

Specify the connection to use from the
Connection file.

-description description

Specify a Connection file. This enables the
use of an alternative appsrv.ini.

-file connection filename

Set alternative protocol file. This enables
the use of an alternative module.ini.

-protocolfile filename

Set alternative client configuration file.
This enables the use of an alternative
wfclient.ini.

-clientfile filename

Display a different name for the client,
specified by name, wherever the client
name appears. The default client name is
the device name. However if you use a
Sunray device, the default name is derived
from the device’s MAC address. This is
overridden by the ClientName entry in
.ICAClient/wfclient.ini, which is itself
overridden by issuing the -clientname
name command.

-clientname name

Show this list of parameters.

-help

Display version information.

-version

Show error numbers and string.

-errno

Set the location of UNIX client installation
files. This is equivalent to setting the
ICAROOT environment variable.

-icaroot directory

Suppress connection dialogs.

-quiet

Turn off the splash screen.

-nosplash

Log connection process.

-log

Citrix Receiver for Linux Command-Line Parameters
Enable keyword logging.

-keylog

Set session geometry.

-geometry WxH+X+Y

Set color depth.

-depth <4 | 8 | 16 | 24 | auto>

Set monitor spanning.

-span [h][o][a|mon1[,mon2[,mon3,mon4]]]

Use private colormap.

-private

Use shared colormap.

-shared

Specify a string to be added to a published
application.

-param string

Specify the UNIX path to be accessed
through client drive mapping by a
published application.

-fileparam unixpath

Specify a user name.

-username username

Specify a disguised password.

-password password

Specify a clear text password.

-clearpassword clear password

Specify a domain.

-domain domain

Specify an initial program.

-program program

Specify a directory for the intial program
to use.

-directory directory

Turn on sound.

-sound

Turn off sound.

-nosound

Set drive mapping overrides. These are of
the form A$=path, where path can contain
an environment variable (for example
A$=$HOME/tmp). This option must be
repeated for each drive to be overridden.
For the override to work, there must be an
existing mapping, though it need not be
enabled.

-drivemap string

Associate document with published
application.

-associate

Only launch the associated published
application. Do not open the document.

-launchapponly

Tip: All wfica command line options can also be specified in the environment variable
WFICA_OPTS, allowing them to be used with wfcmgr and the Web Interface.

157

